Acknowledgements

The development, printing and distribution of this student textbook has been funded through the General Education Quality Improvement Project (GEQIP), which aims to improve the quality of education for Grades 1-12 students in government schools throughout Ethiopia.

The Federal Democratic Republic of Ethiopia received funding for GEQIP through credit/financing from the International Development Associations (IDA), the Fast Track Initiative Catalytic Fund (FTICF) and other development partners—Finland, Italian Development Cooperation, the Netherlands and UK aid from the Department for International Development (DFID).

The Ministry of Education wishes to thank the many individuals, groups and other bodies involved—directly and indirectly—in publishing the textbook and accompanying teacher guide.

© Federal Democratic Republic of Ethiopia, Ministry of Education
First edition, 2002 (E.C.)


All rights reserved; no part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise without the prior written permission of the copyright owner or a licence permitting restricted copying in Ethiopia by the Federal Democratic Republic of Ethiopia, Federal Negrit Gazeta, Proclamation No. 8/0 Cop y i ng and Neigh bor ing Ri g h ts Protection Proclamation, 8th year, No. 5 Addis Ababa, 9 July 8

Disclaimer

Every effort has been made to trace the copyright owners of material used in this document. We apologise in advance for any unintentional omissions. We would be pleased to insert the appropriate acknowledgement in any future edition.

Printed in India.
## CONTENTS

**Unit 1: Information Systems**

1.1 Basics of E-learning ......................................................... 1
1.2 Basics of E-Government ................................................... 9
1.3 Basics of E-Banking ......................................................... 15
1.4 Basics of E-Libraries ......................................................... 17
1.5 Basics of E-Commerce ....................................................... 19
1.6 System Analysis ............................................................... 23

**Review Questions** ............................................................ 28

**Unit 2: Enhancing the Use of Software**

2.1 Using Application Software ............................................. 30

**Review Questions** ............................................................ 56

**Unit 3: Exploiting the Internet**

3.1 General Concept of Website Design ................................. 58
3.2 Planning a Website ............................................................ 64
3.3 Website Design Considerations ....................................... 67
3.4 Website Development ....................................................... 69

**Review Questions** ............................................................ 75

**Unit 4: Image Processing and Multimedia Systems**

4.1 Basics of Multimedia ....................................................... 77
4.2 Multimedia Authoring ..................................................... 80
4.3 Introduction to Multimedia Authoring Tools ..................... 82
4.4 Inserting and Editing Text ................................................ 85
4.5 Working with Images and Graphics ................................... 87
4.6 Page Transitions, Positioning and Motion Icon ................... 88
4.7 Libraries ................................................................. 92
4.8 Working with Sound and Digital Movies ......................... 94
4.9 Overview of Film Editing ............................................... 97

**Review Questions** ............................................................ 101

**Glossary** .......................................................................... 103
PREFACE

Information and Communication Technology (ICT) is so important in the world today that makes it imperative for every person to be competent in the use of ICT for the many tasks that one will have to accomplish. This book is written to provide excellent ICT skills for Grade 12 students of Federal Democratic Republic of Ethiopia. It is expected that the knowledge and skills gained through this book will help the students to use ICT in almost all their courses at school. The book covers selected topics in ICT which offer hands-on activities to help students in acquiring the advanced ICT skills.

The key features of this book will help the students to:

- acquire advanced ICT literacy.
- understand the Information Systems i.e. E-learning, E-commerce, E-government, E-banking, and E-libraries.
- have an overview of system analysis.
- enhance the use of software.
- develop interest and use ICT for learning in other subjects.
- exploit the Internet.
- understand the concept of webpage design and differentiate between the different kinds of websites.
- recognize the steps required for website design, and design a simple and attractive website.
- follow basic ethics in the use of ICT.
- use image processing and multimedia systems effectively.
- have excellent ICT skills which will serve them well in their future studies.

The text has been designed in a simple and user friendly way. It focuses on the applications of ICT, which change slowly. This book also illustrates the latest developments in the rapidly changing world of ICT. Review questions have also been given at the end of each unit.

In future years, the knowledge gained through this book will be very useful to students, in case they elect to follow a more-specialist course in Computer Science covering such areas as Computer Architecture, Systems Analysis and Design, Data Communications and Fundamentals of Programming.

Suggestions for the improvement of this book will be gratefully acknowledged.

Authors
UNIT OUTCOME

Students will be able to:

understand the concept of e-learning, e-commerce, e-government, e-banking and e-libraries.

Social and Economic Implications of ICT

Electronic technologies are playing an important role in shaping the mindset of Ethiopian citizens, and they will want that mindset reflected in social governance.

These days large business enterprises use electronic commerce to conduct their business-to-business transactions. Electronic Data Interchange (EDI) on private networks began in the 1960s and banks have been using dedicated networks for Electronic Funds Transfer (EFT) almost as long. Recently however, with the increased awareness and popularity of the Internet, electronic commerce has become very popular among individual consumers as well as businesses of all sizes.

The Internet has changed the way of conducting the business in many companies. As its influence grows and more companies use the Internet, the possibilities for conducting business-to-business commerce on the Internet will expand greatly and become more of a routine part of commerce than it is today. We have not yet reached in that position where everyone thinks of conducting business-to-business commerce on the Internet everyday, but we will.

1.1 BASICS OF E-LEARNING

Learning is the process of acquiring knowledge or skills by instruction or study. Traditionally, learning has been imparted using a static content, which does not change for the duration of a grade or a training session. However, with an increase in the use of the Internet, the focus is now shifting to Web-based Training (WBT). In WBT, content is placed on a Website and learners can gain access to it.

The world’s Information and Communications Technology (ICT) education and training market is growing rapidly all over the world. The growth rates are higher in the Asian region. The ICT training markets in China, India, and Korea are expected to grow at over 25 percent each. The West African region is also coming up in this field. Adama University in Ethiopia has already instigated the first self-developed, campus-wide e-learning environment in the university.

Skilled jobs will constitute 85 percent of all jobs in the new economy. Individuals, therefore, need to continuously upgrade their skills. The average age of an e-learner is 40. So, the lifelong learning is the emerging trend in the knowledge economy. Consequently, there is a huge demand for customized learning solutions, anytime and anywhere. E-learning is emerging as the most significant response to the demands of individual learning.
● Definition of Electronic Learning

Electronic Learning or E-learning is a flexible term used to describe a means of learning through technology such as a network, browser, CD-ROM or DVD multimedia platforms.

Some other terms frequently interchanged with e-learning include:

(i) Online learning
(ii) Online education
(iii) Distance education
(iv) Distance learning
(v) Technology-based training
(vi) Web-based training
(vi) Computer-based training (generally thought of as learning from a CD-ROM)

Distance education provides the base for e-learning’s development. E-learning can be “on demand”. It overcomes timing, attendance and travel difficulties.

The e-learning is an umbrella term that describes learning done at a computer, usually connected to a network, giving the opportunity to learn almost anytime, anywhere. E-learning is efficient as it eliminates distances and subsequent travelling. Distance is eliminated because the e-learning content is designed with media that can be accessed from properly equipped computer terminals, and other means of Internet accessible technology. Brandon Hall, a noted e-learning researcher, defines e-learning as *instruction delivered electronically wholly by a web browser, through the Internet or an Intranet, or through CD-ROM or DVD multimedia platforms.* (Source: www.namahn.com)

Today’s e-learning tools go beyond computers to include MP3 players, podcasts, blogs and more.

As there is limited social interaction in an e-learning set up, students must keep themselves motivated; they must communicate with each other and the instructor frequently to accomplish their assigned tasks. Figure 1.1 shows an academic e-learning model.

![Fig. 1.1: An academic e-learning model](image)
Levels of E-learning

E-learning falls into the following four categories, from the very basic to the very advanced.

1. **Knowledge Databases.** You have probably seen knowledge databases on software sites offering indexed explanations and guidance for software questions, along with step-by-step instructions for performing specific tasks. These are usually moderately interactive, meaning that you can either type in a key word or phrase or search the database, or make a selection from an alphabetical list.

2. **Online Support.** This is also a form of e-learning and functions in a similar manner to knowledge databases. Online support comes in the form of forums, chat rooms, online bulletin boards, e-mail, or live instant-messaging support. Slightly more interactive than knowledge databases, online support offers the opportunity for more specific questions and answers, as well as more immediate answers.

3. **Asynchronous Training.** This is e-learning in the more traditional sense of the word. It involves self-paced learning, either CD-ROM-based, network-based, Intranet-based or Internet-based. It may include access to instructors through online bulletin boards, online discussion groups and e-mail. Or, it may be totally self-contained with links to reference materials in place of a live instructor.

4. **Synchronous Training.** This is done in real-time with a live instructor facilitating the training. Everyone logs in at a set time and can communicate directly with the instructor and with each other. This type of training usually takes place via Internet Websites, audio- or video-conferencing, Internet telephony, or even two-way live broadcasts to students in a classroom.

● Advantages and Disadvantages of E-learning

**Advantages**

The e-learning setup, if implemented in quality way, offers many benefits to the users. The main advantages of e-learning are given below:

1. **First-in Market:** The e-learning model enables the placement of content on the Web as soon as it is ready without having to wait for printing, packaging and shipping through distribution channels. This results in cutting down the lead-time between the development of a course and its availability to learners. The early availability of content gives the learner a headstart over others.

2. **Learner Control:** You can learn at any time and at any place. All you need for e-learning is a Web connection. You can limit the duration of an e-learning session to study only the volume of content that you can fully absorb.

3. **Enhanced Retention:** Since you follow a learning style that suits you, e-learning enhances your retention. Also, the e-learning material is delivered in small logical modules known as skillets. This results in better retention and recall for a learner.

4. **Timely and Easy Access:** E-learning is available 24 hours a day, 7 days a week. Therefore, e-learning enables you to learn at the time that is convenient to you. The timely retrieval of the learning material enables you to practice what you have learned. You can gain access to the e-learning material from any location that has a computer and an Internet access.

5. **Interactive Mode:** As an e-learner, you have access to a Web tutor at all times. Experts are also available for you to resolve content-related queries. E-learning also allows you to chat with co-learners on different topics related to their subject and participate in discussion forums. Ch t is th tp d i scussion am ong p r tic p nts w h are online at th same time; it is just like tel e p ne conversation, ex ep th t messag s are tp d rath r th n sp ken.
6. **Assessment and Feedback:** E-learning provides you with assessment exercises that test you on the course that you are learning. On-line tests are typically optional self-initiated tests. You get a dynamic set of questions to answer. Unlike tests in CBT (Computer-based Training), these tests give you a feedback comparing your performance with that of other learners who have attempted the test.

7. **Up-to-date Content:** The e-learning technology allows the dynamic updation of information on courses. Therefore, unlike CBT or books, the content in an e-learning course is updated regularly. This enables you to gain access to the latest information on the course.

8. **State-of-the-art Environment:** The future of all activities in educational and commercial spheres is on the Internet. Therefore, most of the new development in educational technologies is Web-based. Most transactions are changing from physical to virtual, and the Internet is at the core of everything. Therefore, with e-learning, you work in a state-of-the-art environment that is going to be the environment of the future.

**Disadvantages**

Although e-learning is very useful for the users, but it suffers from some limits that lead to its disadvantages. The disadvantages of e-learning are given below:

1. **Up-front Investment:** Up-front investment required for an e-learning solution is larger due to development costs. Budgets and cash flows will have to be negotiated.

2. **Technology Issues:** Technology issues that play a factor include whether the existing technology infrastructure can accomplish the training goals, whether the additional technology expenditures can be justified, and whether compatibility of all software and hardware can be achieved.

3. **Inappropriate Content:** Inappropriate content for e-learning may exist according to some experts, though is limited in number. Even the acquisition of skills that involve complex physical/motor or emotional components (for example, juggling or mediation) can be augmented with e-learning.

4. **Cultural Acceptance:** Cultural acceptance is an issue in organizations where student demographics and psychographics may predispose them against using computers at all, let alone for e-learning, unavailability of required technologies.

5. **Portability:** Portability of training has become a strength of e-learning with the proliferation of network linking points, notebook computers, PDAs, and mobile phones, but still does not rival that of printed workbooks or reference material.

6. **Reduced Social and Cultural Interaction:** Reduced social and cultural interaction can be a drawback. The impersonality, suppression of communication mechanisms such as body language, and elimination of peer-to-peer learning that are part of this potential disadvantage are lessening with advances in communications technologies.

**Technology Necessary for E-learning**

The different types of e-learning are based on:

(i) Means of communication

(ii) Schedule

(iii) E-learning class structure

(iv) Technologies used
Technology is the most variable element in e-learning. The more advanced the technology becomes, the more options there are to further e-learning. It has increasingly limitless potential.

**Information Technology**

Today information technology involves more than just computer literacy; it also takes into account how computers work and how these computers can further be used not just for information processing but also for communications and problem solving tasks as well (see Fig. 1.2).

Our world today has changed a great deal using information technology. Things that were once done manually or by hand have now become computerized, which simply require a single click of a mouse to get a task completed. With the aid of IT we are not only able to streamline our business processes but we are also able to get constant information in ‘real time’ that is up to the minute and up-to-date.

The significance of IT can be seen from the fact that it has penetrated almost every aspect of our daily lives from business to leisure and even society. Today PCs, cell phones, fax machines, pagers, e-mail and Internet have all not only become an integral part of our culture but also play an essential role in our day-to-day activities.

**Telecommunication Technology**

Telecommunication is the transmission of messages over significant distances for the purpose of communication.

Telecommunications as a word has its origins in Greek. It is a combination of *tele* which means ‘Far Off’ and *communications* which is an ‘exchange of information’. In its simplest terms “a far off exchange of information”.

Other early forms of telecommunications were signal flags and lights. More modern uses were the telegraph, telephone and even data transmissions. Even radio and TV are forms of telecommunications; television even has the same root word *tele*.

The basic elements of a telecommunications system are:

1. A transmitter, this device will take the information to be communicated and produce.
2. A signal to be transported.
3. A transmission medium, this could be over a wire or over the air using the airwaves. The transmission medium, by its physical nature, is likely to modify or degrade the signal on its path from the transmitter to the receiver.
4. A receiver, this device will reverse any actions performed by the transmitter in the exact reverse order of the transmitter. The receiver can be designed to tolerate a significant degree of signal degradation.

Telecommunication can be point-to-point, from one transmitter to one receiver or point-to-multipoint which is also known as broadcasting. Figure 1.3 shows telecommunication technology helping Ethiopian people.
The Ethiopian Telecommunications Corporation (ETC) is the sole operator of all telecommunications related services including the provision of Internet and public phone in Ethiopia.

**Internet Connection**

Though our society is not quite living in space, we have made life easier with technology. Economic survival has become more dependent upon information and communications bringing forth new technology of which was never thought possible. Just a mere thirty years ago a computer occupied a whole room compared to today’s palm-sized computers, which are faster and perform more functions. Cellular phones, now light and compact, were bulky just ten years ago.

The most incredible invention, the Internet, is bringing infinite amount of information to us (see Fig. 1.4). In the world of the Internet, there exists a world blind to skin colour and other physical appearances. The Internet while still young in age has grown rapidly, spreading to countries worldwide and connecting the millions of users. With its popularity, the Ethiopian people should also recognize how the Internet works and be aware of its advantages as well as disadvantages.

While seemingly high tech, the Internet concept is rather simple. Computers speak to one another and send information. This is done by sending and receiving electronic impulse, and then decoding them into a message. In order to communicate with one another they are linked up in a network. They are then able to access information from thousands of other computers. The network acts like one large computer storing information in various places, rather than in one physical structure. Users tap into the Internet to access or provide information. Internet technology allows one to surf the World Wide Web or send e-mail.

- **How E-learning Works?**

E-Learning can be done using an Internet connection, a network, an intranet, or a storage disk. It uses a variety of media like audio, text, virtual environments, video, and animation. E-Learning, in some ways, is even better than classroom learning methods as it is a one-on-one learning method and self-paced.

**Analogy**

E-learning is to classroom learning as cell phones are to pay phones at the bus station.

Well, at least it is in some ways. For instance, e-learning allows you to learn anywhere and usually at any time, as long as you have a properly configured computer. Cell phones allow you to communicate anytime and usually anywhere, as long as you have a properly configured phone.
The e-learning programs feature real-world applications and use a multi-pronged approach involving interactive online Internet web casts, simulation software and self-study assignments with a mentor on call. The courses consist of a set number of modules delivered over a given time frame. Presentations and group discussions are conducted using a live, interactive software system. For each e-learning module the users generally have an initial reading assignment (which is delivered to him/her in electronic format in advance of the online presentations). Figure 1.5 shows a model of e-learning.

<table>
<thead>
<tr>
<th>Stage</th>
<th>Aim of support</th>
<th>Result</th>
<th>Measures</th>
</tr>
</thead>
<tbody>
<tr>
<td>Before training</td>
<td>Recruit learners to program</td>
<td>Uptake of e-learning</td>
<td>Targets:</td>
</tr>
<tr>
<td>During training</td>
<td>Support effective learning</td>
<td>Completion of training</td>
<td>Targets:</td>
</tr>
<tr>
<td>After training</td>
<td>Transfer learning to the job</td>
<td>Impact on workplace performance</td>
<td>Targets:</td>
</tr>
</tbody>
</table>

![Fig. 1.5: Model of support for learners using e-learning in workplaces](image)

There are coursework or problems to be submitted and in some cases there are practical exercises, using simulation software and remote labs that the user can easily do from his/her home or office. Users also have ongoing support from the instructors as well as course coordinators via phone, fax and e-mail.

### Activity 1.1

**To Discuss and Describe a Learning Management System**

In groups, students will discuss and describe the Moodle Learning Management system.

**Learning Management System**

A Learning Management System (or LMS) is a software package that enables the management and delivery of learning content and resources to students. Most LMS systems are Web-based — to facilitate “anytime, anywhere” access to learning content and administration.

**What is Moodle?**

Moodle is an Open Source Course Management System (CMS), also known as a Learning Management System (LMS) or a Virtual Learning Environment (VLE). It has become very popular among educators around the world as a tool for creating online dynamic websites for their students. To work, it needs to be installed on a web server somewhere, either on one of your own computers or one at a web hosting company. Figure 1.6 shows the Moodle website.
Some Ways to Use Moodle

The focus of the Moodle project is always on giving educators the best tools to manage and promote learning, but there are many ways to use Moodle:

- Moodle has features that allow it to scale to very large deployments and hundreds of thousands of students, yet it can also be used for a primary school or an education hobbyist.
- Many institutions use it as their platform to conduct fully online courses, while some use it simply to augment face-to-face courses (known as blended learning).
- Many of Moodle users love to use the many activity modules (such as Forums, Wikis, Databases and so on) to build richly collaborative communities of learning around their subject matter (in the social constructionist tradition), while others prefer to use Moodle as a way to deliver content to students (such as standard SCORM packages) and assess learning using assignments or quizzes.

KEY CONCEPTS

- E-learning is a flexible term used to describe a means of learning through technology such as a network, browser, CD-ROM or DVD multimedia platforms.
- The main advantages of e-learning are:
  - First-in market, Learner control, Enhanced retention, Timely and Easy access, Interactive Mode, Assessment and Feedback, Up-to-date content, State-of-the-art Environment.
- Technology is the most variable element in e-learning.
- Technology necessary for e-learning are:
  - Information Technology, Telecommunication Technology and Internet connection.
ASSessment 1.1

Fill in the Blanks

1. ...................................... is emerging as the most significant response to the demands of individual learning.
2. The technology necessary for e-learning are ....................., ..................... and ......................
3. LMS stands for ......................... .
4. ...................................... is the transmission of messages over significant distances for the purpose of communication.

State Whether True or False

1. Moodle is a Learning Management System.
2. E-learning falls into seven categories.
3. E-learning is also known as electronic government.
4. E-learning is also termed as Web-based training.

Answer the Following

1. Define e-learning.
2. Describe the advantages and disadvantages of e-learning.
3. List the necessary technologies for e-learning.
4. Explain how e-learning works.

Suggested Activities

1. Explain the meaning of e-learning.
2. Let the teacher demonstrate the concept of e-learning with analogy to traditional face-to-face learning.

Field Trip

E-learning uses electronic links to extend school/college campuses to people who otherwise would not be able to take school/college courses. Visit any big educational organization which provides e-learning and prepare a short report on:

(i) basics of e-learning  (ii) technology necessary for e-learning.

1.2 BASICS OF E-GOVERNMENT

Electronic systems now reach into all levels of government, into the workplace, and into private lives to such an extent that even people without access to these systems are affected in significant ways by them. Some examples of electronic systems are listed below:

(i) E-learning system  (ii) E-government system
(iii) E-banking system  (iv) E-libraries system
(v) E-commerce system
Now, let us discuss the basics of e-government:

The term “e-government” is extensive and applicable to any government entity, not only nationally but globally. E-government is the use of ICT to support government operations, engage citizens, and provide government services.

**Definition of E-government**

E-government, also known as electronic government, refers to government’s use of information technology to exchange information and services with citizens, businesses, and other arms of government.

or

E-government refers to the use by government agencies of information technologies (such as Wide Area Networks, the Internet, and mobile computing) to transform relations with citizens, businesses, and other arms of government.

These technologies can serve a variety of different ends: better delivery of government services to citizens, improved interactions with business and industry, citizen empowerment through access to information, or more efficient government management. The resulting benefits can be—less corruption, increased transparency, greater convenience, revenue growth, and cost reductions. Figure 1.7 shows trying e-government in Addis Ababa, Ethiopia.

![Fig. 1.7: Trying e-government in Addis Ababa, Ethiopia](image)

Traditionally, the interaction between a citizen or business and a government agency takes place in a government office. With emerging information and communication technologies it is possible to locate service centres closer to the clients. Such centers may consist of an unattended kiosk in the government agency, a service kiosk located close to the client, or the use of a personal computer in the home or office.

**Features of e-governance**

E-governance provides the following three major functions:

1. **e-administration**: improving government processes by cutting costs, managing performance, making strategic connections within government, and creating empowerment.
2. **e-citizens and e-services**: connecting citizens to government by talking to citizens and supporting accountability, listening to citizens and supporting democracy, and improving public services.
3. **e-society**: building interactions beyond the boundaries of government by working better with business, developing communities, building government partnerships, and building civil society.
Figure 1.8 shows e-governance model.

- **Advantages of E-government**

Some advantages of implementing an electronic government are given below:

The main advantage of an electronic government is to improve the efficiency of the current government system. That would in return save money and time. The introduction would also facilitate better communications between governments and businesses. An example would be, e-procurement which facilitates Government-to-Government (G2G) and Business-to-Business (B2B) communication; this will permit smaller business to compete for government contracts as well as larger business. This will have the advantage of creating an open market and stronger economy. Business and citizens can obtain information at a faster speed and it is possible at anytime of the day.

In addition, moving away from a heavily paper based system to an electronic system would reduce the need for manpower. Thus, this would allow the process to be handled by lesser employees and therefore to reduce operations cost.

The society is moving toward the mobile connections. The ability of an e-government service to be accessible to citizens irrespective of location throughout the country brings the next and potentially biggest benefit of an e-government service. Figure 1.9 shows National Bank of Ethiopia, which is active in implementing e-governance.
WoredaNet Initiative

This is a major e-government initiative that connects all 600 of Ethiopia’s local councils (woredas) to 11 regional capitals through Internet telephone and video-conferencing. Half the links are by cable, and half by satellite. The initiative also provides connectivity to the SchoolNet, eHealth, and the soon-to-be launched AgriNet. WoredaNet is implemented by the Ethiopia Telecommunication Agency with funding from the World Bank and the African Development Bank through the Ministry of Capacity Building.

- Application of E-government

E-government applications empower citizens and businesses to transact government business online that might otherwise require “a trip downtown”. Agencies benefit, too, from reduced paperwork, improved databases, and increased efficiency.

E-government is an important innovation for enhancing good governance and strengthening a country. It can facilitate access to information, freedom of expression, greater equity, efficiency, productivity growth and social inclusion.

Introduction of ICT-based services creates an opportunity to identify flawed processes and re-engineer them, consequently improve not only the efficiency but also the quality of service to citizens. Figure 1.10 shows Internet cafe in Ethiopia.

Successful e-government initiatives offer tangible opportunities which include:

(i) transformation of cumbersome public administration and service delivery processes thereby increase efficiency of governments.

(ii) empowerment and participation of citizens, thereby contribute to strengthening democratic processes.

(iii) greater transparency and accountability, thereby lead to better governance and reduce opportunities for corruption.

(iv) stimulation of the usage of ICT applications in other development sectors (e-health, e-education), thereby opens opportunities to transform agriculture-based economies.
- **Services delivered by E-government**

Analogous to e-commerce, which allows businesses to transact with each other more efficiently Business-to-Business (B2B) and brings customers closer to businesses *i.e.*, Business-to-Consumer (B2C), e-government aims to make the interaction between government and citizens (G2C), government and business enterprises (G2B), and inter-agency relationships (G2G) more friendly, convenient, transparent, and inexpensive. Figure 1.11 shows four types of e-government services.

![Figure 1.11: Four types of e-government services](image)

The four types of e-government services are discussed below:

(i) **Government-to-Citizen (G2C):** This includes information dissemination to the public, basic citizen services such as license renewals, ordering of birth/death/marriage certificates and filing of income taxes, as well as citizen assistance for such basic services as education, health care, hospital information, libraries, and the like.

(ii) **Government-to-Business (G2B):** These transactions include various services exchanged between government and the business community, including dissemination of policies, memos, rules and regulations.

(iii) **Government-to-Employee (G2E):** These services encompass G2C services as well as specialized services that cover only government employees, such as the provision of human resource training and development that improve the bureaucracy’s day-to-day functions and dealings with citizens.

(iv) **Government-to-Government (G2G):** These services take place at two levels—at the local or domestic level and at the international level. G2G services are transactions between the central/national and local governments, and between department-level and attached agencies and bureaus. At the same time, G2G services are transactions between governments, and can be used as an instrument of international relations and diplomacy.
Status of E-government in Ethiopia

A national wide-area network infrastructure is being established in Ethiopia to connect the Federal Government with Regional Governments and District level administration. The nationwide networks are being built that will link government departments, educational and healthcare institutions, and agricultural research centres.

The Ethiopian Telecommunications Corporation (ETC) has deployed an optical network infrastructure that will help transport high-quality voice, data and multimedia services to government departments, companies and the general population. This system provides videoconferencing, Internet connectivity, messaging and information exchange services, which are believed to improve communications between the various tiers of Government to facilitate and enable effective and efficient provision of services to the public.

The Ethiopian economy is based at present mainly on agriculture. Nevertheless, the Government of the country strongly believes that an innovative and technology enhanced national strategy is needed in order to improve public services and to create new long-term opportunities—both for individuals and business enterprises all over the country. A knowledge-based economy is a target providing rich development perspectives in education, health care and agriculture sectors.

The Ethiopian Government, through its Ministry of Capacity Building (MoCB), enlisted ETC to build a core multi-service network. The ICT-led projects are going on to generate large benefits for local communities.

A fibre-optic transmission network conceived by Cisco has been built around Addis Ababa, and it will transport both mobile and fixed-line analogue voice traffic. A combination of high-speed fixed and microwave links are extending existing network to other parts of the country—sometimes covering distances as far as 700 kilometres to the most remote areas of the country.

The status of e-government in Ethiopia will certainly improve in the coming years with implementation of ICTs.

**KEY CONCEPTS**

- E-government is also known as electronic government.
- The main advantage of e-government is to improve the efficiency of the current government system.
- E-government applications empower citizens and businesses to transact government businesses online.
- The four types of e-government services are G2C, G2B, G2E and G2G.
- The status of e-government in Ethiopia will certainly improve in the coming years with implementation of ICT.

**Assessment 1.2**

**Fill in the Blanks**

1. The implementation of .................................................. would improve internal efficiency, the delivery of public services and better accessibility of public services.
2. .................................................. improves government processes by cutting costs, managing performance etc.
3. The four types of e-government services are .................................................., .................................................., .................................................. and ...................................................
State Whether True or False
1. E-government is also known as electronic government.
2. E-governance provides an e-society.
3. The implementation of e-government would not facilitate better communications between governments and businesses.
4. E-government requires “a trip downtown”.
5. The status of e-government in Ethiopia will certainly improve in the coming years.

Answer the Following
1. List some of the electronic systems.
2. Define e-government.
3. Explain the advantage of e-government.
4. Explain the different services by e-government.

Suggested Activities
1. Describe in some detail the main elements of at least some of the electronic systems.
2. Let the teacher explain the definition of e-government and its application, and students may write a small report on the same.

Field Trip
Organize a visit to one of the affrications, e.g., a bank or arrange for a speaker to visit the class. Groups of 4/5 students will offer a presentation of the affrications to the rest of the class. All areas should be covered.

1.3 BASICS OF E-BANCING

To most people, electronic banking means 24-hours access to cash through an Automated Teller Machine (ATM) (see Fig. 1.12) or paychecks deposited directly into checking or savings accounts.

Electronic banking, also known as Electronic Fund Transfer (EFT), uses computer and electronic technology as a substitute for checks and other paper transactions. EFTs are initiated through devices such as cards or codes that you use to gain access to your account. Many financial institutions use an Automated Teller Machine (ATM) card and a Personal Identification Number (PIN) for this purpose.

Advantages of Online Banking
1. Convenience: Online banking saves you the hassle of having to wait in a queue. You can access your account and make transactions whenever you like. This way, you do not have to wait until you
get some free time off work, or spend your weekend writing checks and queuing up at the bank to deposit them. It also saves time. Just sit down in front of your computer and open up a webpage with your account details on it. In a span of a few minutes, you can check your account details and carry out a transaction. There is no need to manually go through your cheque book. Moreover, you avoid the bother of requiring stamps and envelopes to mail cheques to different places.

2. **Organization:** Online banking simplifies your job of having to shuffle through stacks of paper every month, trying to tally receipts with bank statements. Instead, you can just create a spreadsheet on your computer and enter your expenses and account balances on it. Using simple addition, the computer can automatically tally up both of them and check to see if they match.

3. **Reduced paperwork:** With online banking, you are able to avoid the headache of dealing with the papers that tend to accumulate using a regular banking service. Since you can check your account whenever you wish, there is no need for regular bank statements to be sent to you. If you pay bills or make purchases online, you will not have to sign any receipts.

4. **Confidentiality:** You can carry out all your transactions in the privacy of your own home. This means no one is likely to find out your account number or password unless you yourself give it to them. You also do not have to worry about losing your receipts or about dishonest storekeepers acquiring your credit or debit card details.

**Disadvantages of Online Banking**

1. **Security Issues:** An online banking system could be targeted by miscreants. Hackers are constantly looking for ways to exploit loopholes in bank websites as well as online stores. ‘Phishing’ is a term that is used for the scam in which an unauthorized person creates a replica of a website and tricks people into entering their account numbers and passwords. To avoid being tricked, you should always check the security certificate of the website you are using, before you give any details out. Online banking is often targeted by those who indulge in identity theft.

2. **Lack of Documentation:** When business is conducted online, everything is done through the computer screen and no receipts are given. After you make an online transaction, you should always print out a copy of the online confirmation of your payment. Ensure that details like the amount you paid, product description, terms of delivery, etc. are clearly legible on it. Also, write the date of the transaction if it is not mentioned.

3. **System Failure:** On a rare occasion, it is possible for an online system to suffer a failure and crash. If it is serious, all your data records could be lost. Prepare for any possible mishaps by regularly backing up your data on CDs and printing out hard copies of any transactions you carry out. Also, have a good anti-virus program installed on your home computer and update it regularly. This will prevent any loss of data at your end.

**How E-banking Works?**

E-banking or electronic banking involves a variety of transactional areas, ranging from direct deposit of paychecks, obtaining cash from an ATM, to using a debit card to purchase goods and services. Electronic banking and the resulting financial transactions involve the transmission of financial data and transfer of funds through various modes such as computers, phones, and other technological advanced devices. Figure 1.13 shows the dataflow diagram for bank account customer.
1.4 BASICS OF E-LIBRARIES

E-libraries are the physical sites and/or websites that provide 24 hours online access to digitized audio, video, and written material.

E-libraries use audio, video and text technology. Their digital “books” cover various topics of the school syllabus, ranging from social science to literature and from mathematics to ICT. Figure 1.14 shows e-libraries providing quality based service.

Advantages of E-libraries

E-library is not confined to a particular location or a building—it is virtually distributed all over the world. The user can get his/her information on his/her own computer screen by using the Internet. Actually it is a network of multimedia system, which provides fingertip access. The spoken words or the graphical display of e-library is again having a different impact from the words that are printed. In the new environment, owing a document will not be a problem for the library because the user will pay for its uses.

1. No physical boundary: The user of e-library need not to go to the library physically. People from all over the world could gain access to the same information, as long as an Internet connection is available.
2. **Round the clock availability:** E-libraries can be accessed at any time, 24 hours a day and 365 days of the year.

3. **Multiple accesses:** The same resources can be used at the same time by a number of users.

4. **Structured approach:** E-library provides access to much richer content in a more structured manner, that is, we can easily move from the catalogue to a particular book, then to a particular chapter and so on.

5. **Information retrieval:** The user is able to use any search term belonging to the word or phrase of the entire collection. E-library will provide very user friendly interfaces, giving clickable access to its resources.

6. **Preservation and conservation:** An exact copy of the original can be made any number of times without any degradation in quality.

7. **Space:** Whereas traditional libraries are limited by storage space, e-libraries have the potential to store much more information, simply because digital information requires very little physical space to contain them. When a library has no space for extension, digitization is the only solution.

8. **Networking:** A particular e-library can provide the link to any other resources of other e-library very easily, thus a seamlessly integrated resource sharing can be achieved.

9. **Cost:** The cost of maintaining e-library is much lower than that of a traditional library. A traditional library must spend large sums of money paying for staff, book maintenance, rent, and additional books. E-libraries do away with these fees.

### Disadvantages of E-libraries

The computer viruses, lack of standardization for digitized information, quick degrading properties of digitized material, different display standard of digital product and its associated problems, health hazard nature of the radiation from monitor etc.—all make digital libraries at times a handicap.

1. **Copyright:** Digitization violates the copyright law as the thought content of one author can be freely transferred by others without his acknowledgement. So one difficulty to overcome for e-libraries is the way to distribute information. How does e-library distribute information at will while protecting the copyright of the author.

2. **Speed of access:** As more and more computers are connected to the Internet, its speed of access is reasonably decreasing. If new technology will not evolve to solve the problem, then in near future Internet will be full of error messages.

3. **Initial cost is high:** The infrastructure cost of e-library, that is, the cost of hardware, software, leasing communication circuit is generally very high.

4. **Bandwidth:** E-library needs high bandwidth for transfer of multimedia resources, but the bandwidth is decreasing day-by-day due to its overutilization.

5. **Efficiency:** With the much larger volume of digital information, finding the right material for a specific task becomes increasingly difficult.

6. **Environment:** E-libraries cannot reproduce the environment of a traditional library. Many people also find reading printed material easier than reading material on a computer screen.

7. **Preservation:** Due to technological developments, e-library can rapidly become out-of-date and its data may become inaccessible.
How E-libraries Works?

E-library or Digital Library or Online Library or Virtual Library refers to all the library resources that are available online through computers and databases. E-libraries are different from the open Internet, as they have restricted access.

The e-library allows a user to search, retrieve, save and reuse the library resources in real time on the World Wide Web. It is a ‘virtual’ library whose content is the aggregation of many independent websites, rather than a physical collection that is kept in a central repository. We call each website a ‘resource’. The architectural model of a Digital Library is shown in Fig. 1.15 in terms of a data-flow diagram.

![Fig. 1.15: Architectural Model for Client/Server interaction of a Digital Library](image)

Data Flow: The Digital Library Index provides a list of resource documents, from which the end-user can make a selection; this happens in a dialog between end-user and Index server. When the end-user has selected a document of his/her interest, the reference to this document is passed from the Index server to the user’s Web browser. The user’s browser then downloads the referred-to content directly from a resource server for viewing.

1.5 BASICS OF E-COMMERCE

E-commerce or Electronic Commerce, a subset of e-business, is the purchasing, selling, and exchanging of goods and services over a computer network (such as the Internet) through which transactions or terms of sale are performed electronically. Contrary to popular belief, e-commerce is not just on the Web. In fact, e-commerce was alive and well in business to business transactions before the Web back in the 70s via EDI (Electronic Data Exchange) through VANs (Value-Added Networks). 2merkato.com is an e-commerce website that provides business information for investors, suppliers, buyers, traders who are engaged or want to engage in business activities in Ethiopia.

E-commerce can be broken into four main categories—B2B, B2C, C2B, and C2C.

1. **B2B (Business-to-Business)**

Companies doing business with each other such as manufacturers selling to distributors and wholesalers selling to retailers constitute B2B type of e-commerce. Pricing is based on quantity of order and is often negotiable. Figure 1.16 shows B2B exchanges.
B2B exchanges, which draw on data from various databases, act as centralized online markets for buyers and sellers in specific fields, such as car parts or olive oil. Exchanges are expected to evolve into “b-Webs”, or business Webs, encompassing other factors besides price.

2. **B2C (Business-to-Consumer)**

B2C comprises of businesses selling to the general public typically through catalogues utilizing shopping cart software. For example, having a hard time finding a book? Need to purchase a custom, high-end computer system? How about a first class, all-inclusive trip to a tropical island? With the advent of e-commerce, all three things can be purchased literally in minutes without human interaction.

3. **C2B (Consumer-to-Business)**

A consumer posts his/her project with a set budget online and within hours companies review the consumer’s requirements and bid on the project. The consumer reviews the bids and selects the company that will complete the project. Elance empowers consumers around the world by providing the meeting ground and platform for such transactions.

4. **C2C (Consumer-to-Consumer)**

There are many sites offering free classifieds, auctions, and forums where individuals can buy and sell. Thanks to online payment systems like PayPal where people can send and receive money online with ease. eBay’s auction service is a great example where person-to-person transactions take place everyday.

Companies using internal networks to offer their employees products and services online—not necessarily online on the Web—are engaging in B2E (Business-to-Employee) e-commerce.

G2G (Government-to-Government), G2E (Government-to-Employee), G2B (Government-to-Business), B2G (Business-to-Government), G2C (Government-to-Citizen) and C2G (Citizen-to-Government) are other forms of e-commerce that involve transactions with the government from procurement to filing taxes to
business registrations to renewing licenses. There are other categories of e-commerce out there, but they tend to be superfluous.

M-commerce (Mobile commerce) is the buying and selling of goods and services through wireless technology, that is, handheld devices such as cellular telephones and Personal Digital Assistants (PDAs).

**Advantages of E-commerce**

Some of the advantages of Internet and e-commerce in general are:

(i) Speed  
(ii) Cost Saving  
(iii) No Boundaries  
(iv) Ease of Networking

**Applications of E-commerce**

Some of the widely used e-commerce applications are:

(i) Internet Bookshops  
(ii) Grocery Supplies  
(iii) Electronic Newspapers  
(iv) Internet Banking  
(v) Electronic Auctions

---

**Case Study**

**Dynamic Pricing — eBay**

**What is eBay?**

eBay is a website as shown in Fig. 1.17. It is a place for online auctions.

![Fig. 1.17: eBay — Internet auction house (URL: www.ebay.com)](URL: www.ebay.com)

In other words, eBay is Internet auction house. Anybody can sell almost anything they want there. People can buy many things there as well.
To buy and sell items on eBay, people need to register on the site. They can transfer the money in any way they want. A lot of people use PayPal to transfer the money. PayPal is owned by the same people as eBay.

**How eBay Works?**

(i) A seller lists an item on eBay. It may be anything from antiques to cars, books to sporting goods. The seller chooses to accept only bids for the item (an auction-type listing) or to offer the **Buy It Now** option, which allows buyers to purchase the item right away at a fixed price.

(ii) In an online auction, the bidding opens at a price the seller specifies and remains on eBay for a certain number of days. Buyers then place bids on the item. When the listing ends, the buyer with the highest bid wins.

(iii) In a **Buy It Now** listing, the first buyer willing to pay the seller’s price gets the item.

Trading on eBay is easy and it is fun! Best of all, you will never know what you can find!

- **How E-commerce Works?**

E-commerce or electronic commerce works like conventional commerce with the same process of selling and purchasing goods or services for a price. The difference is that goods and services in e-commerce are bought and sold over the Internet using a credit card. Transactions can be done globally 24 hours a day and 7 days a week, unlike conventional commerce. There are no weekly holidays or closing time as with conventional stores.

**The Process**

The merchant showcases the products intended to be sold on a website and specifies the price of each product. The customer logs on to the website, chooses products and adds them to a shopping cart. The customer connects to the transaction server and gives credit card details to purchase the goods. The merchant’s transaction server then connects to the credit card processing server to check if the customer has the required funds to pay for the goods and services purchased.

Once the processing server approves of the transaction and reports that the customer has funds, it authorizes the transfer of funds from the customer’s bank to the bank of the merchant. On receipt of the money, the merchant’s server confirms the sale to the customer and the products are delivered to the customer by the merchant. Figure 1.18 illustrates the working of e-commerce:
KEY CONCEPTS

- E-banking also known as Electronic Fund Transfer (EFT), uses computer and electronic technology as a substitute for checks and other paper transactions.
- E-libraries are the physical sites and/or websites that provide 24-hours online access to digitized audio, video, and written material.
- E-commerce is the purchasing, selling, and exchanging of goods and services over computer network through which transactions or terms of sale are performed electronically.

ASSESSMENT 1.3

Fill in the Blanks

1. ....................... means 24-hours access to cash through an ATM.
2. ....................... use audio, video and text technology on various topics.
3. The various categories of e-commerce are ....................... , ....................... , ....................... and ....................... .
4. Some advantages of Internet and e-commerce are ....................... , ....................... , ....................... and ....................... .

State Whether True or False

1. Electronic Newspapers are e-commerce application.
2. M-commerce does not require wireless technology such as PDAs these days.
3. E-commerce is not a subset of e-business.
4. E-libraries are available round the clock.
5. ATMs do not require a PIN number for transactions.

Answer the Following

1. Explain how e-banking works.
2. Explain how e-libraries works.
3. Explain how e-commerce works.

Suggested Activities

1. Additionally teacher may demonstrate some sample e-government sites from the Internet.
2. Students should explain about e-banking, e-libraries and e-commerce.
3. The students work in groups. They must choose a topic which they have studied in this unit, and design a presentation which gives full information on the topic. The presentation should be at least 15 slides long, and all students in the group must participate in making the slides and providing information.

1.6 SYSTEM ANALYSIS

A system is defined as a collection of related components that interact to perform a task in order to accomplish a goal. A system may not work very well, but it is nevertheless a system. The point of systems analysis and design is to ascertain how a system works and then take steps to make it better.
Let us consider a system that is familiar to you: a library system (see Fig. 1.19).

**Case Study**

**Library System**

Let us consider a system that is familiar to you: a library system (see Fig. 1.19).

How is library a system? Let us take a look at the fictional Ethiopian Public Library in Addis Ababa, Ethiopia. Every system is a set of some functional units that work together to achieve some specific objective. The main objective of library system is to provide books to its members without difficulty.

This system has many functional units. Books issue and return section, books record unit, member’s record unit, accounts, and report generation units are the different functional units of the library. Each functional unit has its own task. However, each of these works independently to achieve the overall objective of the library.

Data is an important component of any system. Here, data is pertaining to the details of members, books, accounts, and suppliers. Since people can interact with the system, this system is an open system. The system is mainly concerned with the management of data, so it is an information system.

If this system were to be automated as conceived by the management, then role of the system analyst would be to study the system, its workings, and its existing problems. Also the analyst needs to provide a solution to the existing problems.

Now that the management has decided for an automated system the analyst would perform the above tasks. As the analysts did the study of the system, the following problems were identified:

(i) Maintaining membership cards
(ii) Producing reports due to large amount of data
(iii) Maintaining accounts
(iv) Keeping records for books in library and its members
(v) Performing searches

Now that the analyst has studied the system and identified the problems, it is the responsibility of the analysts to provide a solution system to the management of the library.

● Overview

An organization’s computer-based information system consists of hardware, software, people, procedures, and data, as well as communications setups. These work together to provide people with information for running the organization.

An organization may feel the need for a system due to a variety of reasons. Some examples are:
1. A single individual who believes that something badly needs changing is all it takes to get the project rolling.
2. An employee may influence a supervisor.
3. A customer or supplier may get the attention of someone in higher management.
4. Top management may decide independently to take a look at a system that looks inefficient.
5. A steering committee may be formed to decide which of many possible projects should be worked on.

Three types of participants are there in the project as given below:
(i) Users (ii) Management (iii) Technical staff

Complex projects require one or several systems analysts. A systems analyst is an information specialist who performs systems analysis, design, and implementation. The analyst’s job is to study the information and communications needs of an organization and determine what changes are required to deliver better information to people who need it. “Better” information means information that is summarized in the acronym “CART”—complete, accurate, relevant, and timely. The systems analyst achieves this goal through the problem-solving method of systems analysis and design.

Modelling tools enable a systems analyst to present graphic, or pictorial, representations of a system. An example of a modelling tool is a Data Flow Diagram (DFD), which graphically shows the flow of data through a system—that is, the essential processes of a system, along with inputs, outputs and files (see Fig. 1.20).

![Data Flow Diagram](image)

**Explanation of standard data flow diagram symbols used**

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Entity name (person or organization outside the system boundaries)</td>
</tr>
<tr>
<td>File Name</td>
<td>Data Store Symbol</td>
</tr>
<tr>
<td>Name</td>
<td>Process Symbol</td>
</tr>
<tr>
<td>Data Flow Symbol</td>
<td>(inputs and outputs)</td>
</tr>
</tbody>
</table>

**Fig. 1.20: Data flow diagram**
System analysis and design is a six-phase problem-solving process for examining an information system and improving it. The six phases make up what is known as the systems development life cycle. The Systems Development Life Cycle (SDLC) is a step-by-step process that many organizations follow during systems analysis and design.

Whether applied to a very big company or a three-person engineering business, the six phases in systems analysis and design are as shown in Fig. 1.21. Phases often overlap, and a new one may start before the old one is finished. After the first four phases, management must decide whether to proceed to the next phase. User input and review is a critical part of each phase.

![Fig. 1.21: The systems development life cycle (SDLC)](image-url)

**System Problems**

As mentioned earlier an existing system may not work very well. So, the system analyst must identify the system problems as discussed below.

**Identifying System Problem**

One must know what the problem is before it can be solved. Systems are created to solve problems. We can think of the systems approach as an organized way of dealing with a problem.

Problems may be functional—that is, the system may be incomplete, not fulfilling all the program requirements. Problems may be technical (non-functional)—for example, the system may be too slow, sized too small, or be obsolete and inefficient in terms of hardware or software. Problems may also relate to system cost or to access, limiting the ability of personnel to use system information to full potential.

System problem identification step should also include a determination of the seriousness of each problem and its effects on factors such as clients and financial considerations.

**Recognize Functional and Non-functional System Requirements**

The Feasibility Study should include an initial statement of the functional and technical (non-functional) requirements for the system. An overview of the system requirements should reflect a broad range of factors, for example:

(i) Functional, programmatic requirements;  
(ii) Information needs;  
(iii) System needs;  
(iv) Interface and matching requirements;
(v) Processing and data flow needs; (vi) Storage and retrieval requirements;
(\(vi\) i) Inputs; (\(vi\) ii) Outputs;
(ix) Workload, projected overtime; (x) Validation and internal control needs;
(\(xi\) ) Security/Privacy requirements;
(\(xi\) i) Emergency response, back-up, and disaster recovery;
(\(xi\) ii) Accessibility requirements for the disabled; and/or
(\(xi\) v) Space and Environment.

The requirements should be stated briefly and in functional terms, to the extent possible. Their development during the Feasibility Study supports the selection of suitable alternatives. These functional and non-functional requirements are greatly expanded later in the planning phase through the Requirements Analysis.

**Preliminary Investigation**

The objective of Phase 1, preliminary investigation, is to conduct a preliminary analysis, propose alternative solutions, describe costs and benefits, and submit a preliminary plan with recommendations. These steps are given below:

(i) **Conduct the preliminary analysis.** In this step, you need to find out what the organization’s objectives are and the nature and scope of the problem under consideration. Even if a problem pertains only to a small segment of the organization, you cannot study it in isolation. You need to find out what the objectives of the organization itself are. Then you need to see how the problem being studied fits in with them.

(ii) **Propose alternative solutions.** In delving into the organization’s objectives and the specific problem, you may have already discovered some solutions. Other possible solutions can come from interviewing people inside the organization, clients or customers affected by it, suppliers and consultants. You can also study what competitors are doing now a days. With this data, you then have three choices. You can leave the system as is, improve it, or develop a new system.

(iii) **Describe the costs and benefits.** Whichever of the three alternatives is chosen, it will have costs and benefits. In this step, you need to indicate what these are. Costs may depend on benefits, which may offer savings. A broad spectrum of benefits may be derived. A process may be speeded up, streamlined through elimination of unnecessary steps, or combined with other processes. Input errors or redundant output may be reduced. Systems and subsystems may be better integrated. Users may be happier with the system. Customers’ or suppliers’ interactions with the system may be more satisfactory. Security may be improved. Costs may be cut.

(iv) **Submit a preliminary plan.** Now you need to wrap up all your findings in a written report. The readers of this report will be the executives who are in a position to decide in which direction to proceed—make no changes, change a little, or change a lot—and how much money to allow the project. You should describe the potential solutions, costs, and benefits and mention your recommendations.

**System Analysis**

The objective of Phase 2, system analysis, is to gather data, analyze data, and write reports. In this second phase of the SDLC, you will follow the course that management has indicated after having read your Phase 1 feasibility report. We are assuming that they have ordered you to perform Phase 2—to do a careful analysis or study of the existing system in order to understand how the new system you proposed would
differ. This analysis will also consider how people’s positions and tasks will have to change if the new system is put into effect. The steps are:

(i) **Gather data.** In gathering data, you will review written documents, interview employees and managers, develop questionnaires, and observe people and processes at their place of work.

(ii) **Analyze the data.** Once the data has been gathered, you need to come to grips with it and analyze it. Many analytical tools, or modelling tools, are available.

(iii) **Write a report.** After completion of the analysis, you need to document this phase. This report to management should have three parts:

(a) It should explain how the existing system works.

(b) It should explain the problems with the existing system.

(c) It should describe the requirements for the new system and make recommendations on what to do next.

At this stage, not a lot of money will have been spent on the systems analysis and design project. If the costs of going forward appear prohibitive, this is a good time for the managers reading the report to call a halt. Otherwise, you will be asked to go ahead to Phase 3.

1. The SDLC is a comprehensive tool for solving organizational problems, particularly those relating to the flow of computer–based information.

2. A systems analyst is an information specialist who performs systems analysis, design, and implementation.

We will not discuss the remaining phases as these are beyond the scope of this grade level.

### KEY CONCEPTS

- **A system** is defined as a collection of related components that interact to perform a task in order to accomplish a goal.

- **The Systems Development Life Cycle (SDLC)** is a step-by-step process that many organizations follow during systems analysis and design.

- **The Feasibility Study** should include an initial statement of the functional and technical (non-functional) requirements for the system.

- The objective of **System Analysis** is to gather data, analyse the data and write a report.

### Review Questions

**Fill in the Blanks**

1. A ................................. is defined as a collection of related components that interact to perform a task in order to accomplish a goal.

2. ....................................... tools enable a systems analyst to present graphic, or pictorial, representations of a system.

3. ....................................... is a six-phase problem-solving procedure for examining an information system and improving it.

4. The objective of ................................. is to gather data, analyze the data, and write a report.
State Whether True or False

1. The point of systems analysis and design is to ascertain how a system works and then take steps to make it better.
2. Complex projects do not require one or several systems analysts.
3. User input and review is not a critical part of each phase of SDLC.
4. The objective of preliminary investigation is to conduct a preliminary analysis, propose alternative solutions, describe costs and benefits, and submit a preliminary plan with recommendations.

Multiple Choice Questions

1. The different types of e-learning is based on
   (a) Means of communication   (b) Schedule
   (c) E-learning class structure   (d) All of these
2. Which of the following is/are the major function(s) of e-governance?
   (a) E-administration   (b) E-citizens and e-services
   (c) E-society   (d) All of these
3. Which of the following is a category of e-commerce?
   (a) H2H   (b) B2B   (c) K2K   (d) A2D
4. .................................................. is defined a collection of related components that interact to perform a task in order to accomplish a goal.
   (a) System   (b) Benefit   (c) Cost   (d) Information

Match the Following

<table>
<thead>
<tr>
<th>Column A</th>
<th>Column B</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. LMS</td>
<td>(a) Improves government processes by cutting costs, managing performance etc.</td>
</tr>
<tr>
<td>2. E-administration</td>
<td>(b) Use audio, video and text technology on various topics</td>
</tr>
<tr>
<td>3. E-libraries</td>
<td>(c) Enable a system analyst to present graphic, or pictorial, representations of a system</td>
</tr>
<tr>
<td>4. Modelling Tools</td>
<td>(d) Learning Management System</td>
</tr>
</tbody>
</table>

Answer the Following

1. Define a system. How will you identify system problems?
2. Discuss the functional and non-functional system requirements.

Suggested Activities

1. Students should identify system problem.
2. Collect facts for existing system (e.g., interview, observation).
3. Students should identify functional and non-functional system requirements.

Field Trip

Organize a field trip to various organizations to prepare a report on “System Analysis”. Also present the report in your class.
UNIT OUTCOME

Students will be able to:
1. choose appropriate software tools to solve problems, illustrate ideas and clarify thinking in the other subjects chosen for study in Grade 11.

2.1 USING APPLICATION SOFTWARE

From your earlier Grades 9, 10 and 11, you know that software is not only the basic requirement of a computer system, it makes a computer more powerful and useful. We can make railway reservation, send and receive e-mails, and listen to music only when the hardware and software work together.

Software required to solve some specific task of daily use is generally called application software. Some examples of application software are:

1. Word Processing Software
2. Presentation Software
3. Spreadsheet Software
4. Desktop Publishing Software
5. Database Management Software

In this unit, you will enhance the use of application software.

- **Word Processing Software**

“Word Processing” refers to the act of processing the textual information including typing, editing, formatting and printing.

Word processor is the most common application software. The best-known word processing software is probably Microsoft Word. It offers a much improved way of dealing with documents than the typewriter.

**To start MS-word 2007,**

- Double-click on the icon of Word 2007 on the desktop.
- Click `Start` → `All Programs` → `Microsoft Office` → `Microsoft Office Word`

A blank document namely Document1 is created.
Figure 2.1 shows the Word 2007 document screen elements.

Let us revise some Word processing features which have been discussed in the earlier Grades:

**Creating Documents**
Creating a document means entering text using the keyboard. Word processing software has three features that affect this process the *cursor, scrolling, and word wrap*.

**Editing Documents**
Editing is the act of altering your document. Some Edit features are *insert and delete, undo, find and replace, cut/copy and paste, spelling check*, and *grammar check* and *thesaurus*.

**Printing Documents**
Most word processing software gives you options for printing. You can even preview a document before printing it out.

**Saving Documents**
Saving means storing, or preserving, a document as an electronic file permanently—on a hard disk, or CD, etc.

Table 2.1 summarises creating, editing, printing and saving features in Word 2007.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Ribbon Tab, Group</th>
<th>Button</th>
<th>Quick Access Toolbar</th>
<th>Office Button Drop-down List</th>
<th>Shortcut Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>F1</td>
</tr>
<tr>
<td>Open</td>
<td></td>
<td></td>
<td></td>
<td>Open</td>
<td>Ctrl + O</td>
</tr>
<tr>
<td>New document</td>
<td></td>
<td></td>
<td></td>
<td>New, Blank document</td>
<td>Ctrl + N</td>
</tr>
<tr>
<td>Copy selected text</td>
<td>Home, Clipboard</td>
<td></td>
<td></td>
<td></td>
<td>Ctrl + C</td>
</tr>
<tr>
<td>Cut selected text</td>
<td>Home, Clipboard</td>
<td></td>
<td></td>
<td></td>
<td>Ctrl + X</td>
</tr>
</tbody>
</table>

Table 2.1: Summary of Creating, Editing, Printing and Saving Features
Formatting Documents
Formatting means determining the appearance of a document. It can include such tasks as changing the font; aligning text; and inserting elements such as bullets, numbers, symbols and special characters.

Merging Documents
Mail merge can be considered as the most useful utility offered by MS-Word. It creates copies of same letter for multiple recipients in such a way that each letter looks specifically designed for an individual recipient. Each letter will contain different fields like name, address, phone number, etc. In this way, it saves you from the botheration of designing different letters for different recipients.

Table 2.2 summarises formatting and merging features in Word 2007.

**Table 2.2: Summary of Formatting and Merging Features**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Ribbon Tab, Group</th>
<th>Button</th>
<th>Shortcut Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Align Text Left</td>
<td>Home, Paragraph</td>
<td></td>
<td>Ctrl + L</td>
</tr>
<tr>
<td>Align Text Right</td>
<td>Home, Paragraph</td>
<td></td>
<td>Ctrl + R</td>
</tr>
<tr>
<td>Center</td>
<td>Home, Paragraph</td>
<td></td>
<td>Ctrl + E</td>
</tr>
<tr>
<td>Bold</td>
<td>Home, Font</td>
<td></td>
<td>Ctrl + B</td>
</tr>
<tr>
<td>Bullets</td>
<td>Home, Paragraph</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change Case</td>
<td>Home, Font</td>
<td></td>
<td>Shift + F3</td>
</tr>
<tr>
<td>Feature</td>
<td>Location</td>
<td>Shortcuts</td>
<td></td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------------------------</td>
<td>------------------</td>
<td></td>
</tr>
<tr>
<td>Clear Formatting</td>
<td>Home, Font</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Font dialog box</td>
<td></td>
<td>Ctrl + Shift + F</td>
<td></td>
</tr>
<tr>
<td>Font Size</td>
<td>Home, Font</td>
<td>Ctrl + Shift + P</td>
<td></td>
</tr>
<tr>
<td>Format Painter</td>
<td>Home, Clipboard</td>
<td>Ctrl + Shift + C</td>
<td></td>
</tr>
<tr>
<td>Italic</td>
<td>Home, Font</td>
<td>Ctrl + I</td>
<td></td>
</tr>
<tr>
<td>Justify</td>
<td>Home, Paragraph</td>
<td>Ctrl + J</td>
<td></td>
</tr>
<tr>
<td>Underline</td>
<td>Home, Font</td>
<td>Ctrl + U</td>
<td></td>
</tr>
<tr>
<td>Header</td>
<td>Insert, Header &amp; Footer</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Footer</td>
<td>Insert, Header &amp; Footer</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Insert Picture dialog box</td>
<td>Insert, Illustrations</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Page border</td>
<td>Page Layout, Page Background</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Page break</td>
<td>Insert, Pages</td>
<td>Ctrl + Enter</td>
<td></td>
</tr>
<tr>
<td>Page color</td>
<td>Page Layout, Page Background</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Page margins</td>
<td>Page Layout, Page Setup</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Page number</td>
<td>Insert, Header &amp; Footer</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Page size</td>
<td>Page Layout, Page Setup</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Section break (continuous)</td>
<td>Page Layout, Page Setup</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Select recipients</td>
<td>Mailings, Start Mail Merge</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shapes</td>
<td>Insert, Illustrations</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Smart Art</td>
<td>Insert, Illustrations</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Activity 2.1

My Header

Create a Report in Word having Header and Footer, Section Break, Formats, etc.

In small groups, the students will create a report in word having header and footer, section break, formats etc.

Before creating the actual report, let us explain the steps to create a report in MS-Word 2007 having header and footer, section, formats etc.

Applying Header and Footer
To apply header in MS-Word 2007, perform the following steps:

1. Open a new document and type the report.
2. Click on Insert tab.
3. Click Header button in Header & Footer group.
4. Type the text you want in Header.

Similarly, you can apply footer in the report.

Applying Section Break
To apply section break in MS-Word 2007, perform the following steps:

1. Click on Page Layout tab.
2. Position the insertion point to the desired place where you want to apply the section break.
3. Click on Breaks in Page Setup group.
4. In Section Breaks, click on the desired section break option.

Applying Formats
To apply formats in MS-Word 2007, perform the following steps:

1. Click on Home tab.
2. Apply the desired formatting (e.g., bold, italic, alignment, indentation, size and color etc.) by selecting the text using various groups (e.g., Clipboard, Font, Paragraph, Styles etc.)

We have created a report on “Ethiopian Costume” and have applied Header and Footer, Section Break and Formats on it. These are shown on all the pages of this report.

My Footer
ETHIOPIAN COSTUME

1. The Ethiopian traditional costume is made of woven cotton. Ethiopian men and women wear this traditional costume called gabbi or Netella. Women often wear dresses (Kemis) and netella with borders of coloured embroidered woven crosses, but other designs are also used.

Fig. 2.2: Ethiopian costume Netella

2. Other ethnic groups and tribes in the south and west of the country wear different costumes that reflect their own traditions. Some tribes partially cover their body with leather but other do not wear any clothes at all, merely decorating their faces and bodies with distinctive images.

Presentation Software

Presentation software uses graphics, animation, sound and data or information to make presentations. It is general purpose application software that facilitates the creation of presentations on any particular topic like Global Warming, Uses of Internet, Social Networking, Ethiopian Wildlife or any topic of social interest and importance.

Microsoft PowerPoint is a well-known presentation software.

To start PowerPoint 2007,

Double-click on the PowerPoint 2007 icon on the desktop.

or

Click Start → All Programs → Microsoft Office → Microsoft Office PowerPoint 07

A blank presentation namely Presentation1 is created.

Figure 2.3 shows the PowerPoint 2007 window screen elements.
Preparing a Presentation

You can prepare a presentation using a template provided by PowerPoint or create your own presentation and apply formatting. Preparing a presentation includes steps such as creating and editing slides; adding enhancements to slides; and saving, running, previewing, printing and closing a presentation.

Transition refers to how one slide is removed from the screen and the next slide is displayed, while running a presentation. You can add interesting transitions to slides as well as sound to presentation.

Table 2.3 summarises presentation preparation features in PowerPoint 2007.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Ribbon Tab, Group</th>
<th>Button</th>
<th>Quick Access Toolbar</th>
<th>Office Button Drop-down List</th>
<th>Shortcut Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help</td>
<td></td>
<td></td>
<td></td>
<td>F1</td>
<td></td>
</tr>
<tr>
<td>New Presentation dialog box</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open blank presentation</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>New Slide</td>
<td>Home, Slides</td>
<td>📝</td>
<td></td>
<td></td>
<td>Ctrl + N</td>
</tr>
<tr>
<td>Open dialog box</td>
<td></td>
<td>📠</td>
<td></td>
<td>Open</td>
<td>Ctrl + O</td>
</tr>
<tr>
<td>Normal view</td>
<td>View, Presentation Views</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Feature</td>
<td>Function</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-----------------------------------------------</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Slide Sorter view</td>
<td>View, Presentation Views</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Notes Page view</td>
<td>View, Presentation Views</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zoom dialog box</td>
<td>View, Zoom</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Layout</td>
<td>Home, Slides</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Slide orientation</td>
<td>Design, Page Setup</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Spelling</td>
<td>Review, Proofing</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Thesaurus</td>
<td>Review, Proofing</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Transition Sound</td>
<td>Animations, Transition to This Slide</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Transition Speed</td>
<td>Animations, Transition to This Slide</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Apply transitions and sound to all slides</td>
<td>Animations, Transition to This Slide</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Run presentation from Slide 1</td>
<td>Slide Show, Start Slide Show</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Run presentation from current slide</td>
<td>Slide Show, Start Slide Show</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save As</td>
<td>Save As</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Print dialog box</td>
<td>Print</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Print presentation</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Exit PowerPoint</td>
<td>Exit PowerPoint</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Editing, Enhancing and Customizing Slides**

You can edit, enhance and customize slides and slide elements in a presentation to customize and personalize the presentation. These include rearranging and deleting slides; cutting, copying and pasting text; changing the font, paragraph alignment, and paragraph spacing; and changing the design theme, theme color, and theme font. You can add visual appeal to a presentation by inserting clip art images, pictures, and other graphics. You can customize a presentation by inserting table and sound etc.
Table 2.4 summarises editing, enhancing and customizing slides features in PowerPoint 2007.

**Table 2.4: Summary of Editing, Enhancing and Customizing Slides Features**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Ribbon Tab, Group</th>
<th>Button</th>
<th>Shortcut Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Align text left</td>
<td>Home, Paragraph</td>
<td></td>
<td>Ctrl + L</td>
</tr>
<tr>
<td>Align text right</td>
<td>Home, Paragraph</td>
<td></td>
<td>Ctrl + R</td>
</tr>
<tr>
<td>Center</td>
<td>Home, Paragraph</td>
<td></td>
<td>Ctrl + E</td>
</tr>
<tr>
<td>Justify</td>
<td>Home, Paragraph</td>
<td></td>
<td>Ctrl + J</td>
</tr>
<tr>
<td>Align text vertically</td>
<td>Home, Paragraph</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Animate object</td>
<td>Animations, Animations</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bold</td>
<td>Home, Font</td>
<td></td>
<td>Ctrl + B</td>
</tr>
<tr>
<td>Italic</td>
<td>Home, Font</td>
<td></td>
<td>Ctrl + I</td>
</tr>
<tr>
<td>Underline</td>
<td>Home, Font</td>
<td></td>
<td>Ctrl + U</td>
</tr>
<tr>
<td>Copy selected text</td>
<td>Home, Clipboard</td>
<td></td>
<td>Ctrl + C</td>
</tr>
<tr>
<td>Cut selected text</td>
<td>Home, Clipboard</td>
<td></td>
<td>Ctrl + X</td>
</tr>
<tr>
<td>Paste selected text</td>
<td>Home, Clipboard</td>
<td></td>
<td>Ctrl + V</td>
</tr>
<tr>
<td>Replace</td>
<td>Home, Editing</td>
<td></td>
<td>Ctrl + H</td>
</tr>
<tr>
<td>Delete slide</td>
<td>Home, Slides</td>
<td></td>
<td>Delete</td>
</tr>
<tr>
<td>Font</td>
<td>Home, Font</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Font color</td>
<td>Home, Font</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Font dialog box</td>
<td>Font group dialog box launcher</td>
<td></td>
<td>Ctrl + Shift + F</td>
</tr>
<tr>
<td>Font size</td>
<td>Home, Font</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Format Painter</td>
<td>Home, Clipboard</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hide slide</td>
<td>Slide Show, Set Up</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Increase font size</td>
<td>Home, Font</td>
<td></td>
<td>Ctrl + Shift + &gt;</td>
</tr>
<tr>
<td><strong>Activity 2.2</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-----------------</td>
<td>--</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Prepare a Presentation for a Project (Say Ethiopian Wildlife).</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Students in groups will perform the following steps:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1. Click <strong>Start → All Programs → Microsoft Office → Microsoft Office PowerPoint 2007</strong>.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2. Prepare a presentation on “Ethiopian Wildlife” and save it in a file.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3. Click the <strong>Slide Show</strong> tab.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4. Click the <strong>From Beginning</strong> icon in the <strong>Start Slide Show</strong> command group. PowerPoint displays the first slide of the presentation (see Fig. 2.5 slide 1).</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
5. Click the left mouse button or press the spacebar/Enter key to view the next slide.

All the slides in the presentation are shown in Fig. 2.5.
6. Press Esc to exit the slide show.

- **Spreadsheets**

Spreadsheet software is general purpose software application. It allows users to create tables and financial schedules by entering data and formulas into rows and columns in a document called a worksheet. More than one worksheet can be created and saved in a file called a work book. Microsoft Excel is a popular example of spreadsheet software.

**To start Excel 2007,**

Double-click on the Excel icon on the desktop.

or

Click Start → All Programs → Microsoft Office → Microsoft Office Excel

When you start MS-Excel, it directly creates a workbook for you. An Excel workbook initially contains three worksheets labeled Sheet 1, Sheet 2, and Sheet 3. Each worksheet in Excel contains 16,384 columns and 1,048,576 rows. You can use those worksheets as per your need. At any time, you can insert a new worksheet. Figure 2.6 shows the Excel 2007 screen elements.

![Excel 2007 screen elements](image-url)
Let us revise some spreadsheet features which have been discussed in the earlier Grades.

**Creating Worksheets**

You can enter labels in columns or rows to create the worksheet layout. Next, enter the values that correspond to the entered labels. You can create formulas to add, subtract, multiply, or divide to calculate the desired results.

Table 2.5 summarises creating worksheet features in Excel 2007.

<table>
<thead>
<tr>
<th><strong>Table 2.5: Summary of Creating Worksheet Features</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Feature</strong></td>
</tr>
<tr>
<td>-------------------</td>
</tr>
<tr>
<td>Help</td>
</tr>
<tr>
<td>New workbook</td>
</tr>
<tr>
<td>Open</td>
</tr>
<tr>
<td>Close a workbook</td>
</tr>
<tr>
<td>Fill Down</td>
</tr>
<tr>
<td>Fill Right</td>
</tr>
<tr>
<td>Fill Up</td>
</tr>
<tr>
<td>Fill Left</td>
</tr>
<tr>
<td>Go To</td>
</tr>
<tr>
<td>Save</td>
</tr>
<tr>
<td>Save as</td>
</tr>
<tr>
<td>SUM function</td>
</tr>
<tr>
<td>Exit Excel</td>
</tr>
</tbody>
</table>

**Editing Worksheet**

Editing refers to changing or modifying the existing text. In MS-Excel, you may need to change the contents of a cell. Selecting the cell and typing the data will overwrite the existing data stored in that cell. Excel offers a number of ways to edit the contents of the cell. After editing, always spell check and proofread the worksheet.

**Formatting Worksheet**

Formats can be applied to any cell using the various formatting options, that is, font, font size, font color, bold, italic etc. *Format Painter* copies formats from a selected cell to another cell. Use this feature to apply multiple format options from one cell to another cell.
**Printing Worksheets**

We can print a worksheet to have a hard copy to file or to attach to a report. The *Quick Print* button on the *Quick Access Toolbar* will print the active worksheet using default print options. Use *Print Preview* before printing.

Table 2.6 summarises of editing, formatting and printing worksheets features in Excel 2007.

**Table 2.6: Summary of Editing, Formatting and Printing Worksheet Features**

<table>
<thead>
<tr>
<th>Features</th>
<th>Ribbon Tab, Group</th>
<th>Button</th>
<th>Quick Access Toolbar</th>
<th>Shortcut key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Align Text Left</td>
<td>Home, Alignment</td>
<td>📝</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Align Text Right</td>
<td>Home, Alignment</td>
<td>📝</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Center</td>
<td>Home, Alignment</td>
<td>📝</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bold</td>
<td>Home, Font</td>
<td>✍️</td>
<td></td>
<td>Ctrl + B</td>
</tr>
<tr>
<td>Italic</td>
<td>Home, Font</td>
<td>✰</td>
<td></td>
<td>Ctrl + I</td>
</tr>
<tr>
<td>Borders</td>
<td>Home, Font</td>
<td>🟢</td>
<td></td>
<td>Ctrl + I</td>
</tr>
<tr>
<td>Cell Styles</td>
<td>Home, Styles</td>
<td>📚</td>
<td></td>
<td>Ctrl + I</td>
</tr>
<tr>
<td>Clear cell</td>
<td>Home, Editing</td>
<td>🗑️</td>
<td></td>
<td>Ctrl + I</td>
</tr>
<tr>
<td>Column Width</td>
<td>Home, Cells</td>
<td>📡</td>
<td></td>
<td>Ctrl + I</td>
</tr>
<tr>
<td>Copy</td>
<td>Home, Clipboard</td>
<td>📄</td>
<td></td>
<td>Ctrl + C</td>
</tr>
<tr>
<td>Cut</td>
<td>Home, Clipboard</td>
<td>✂️</td>
<td></td>
<td>Ctrl + X</td>
</tr>
<tr>
<td>Paste</td>
<td>Home, Clipboard</td>
<td>📄</td>
<td></td>
<td>Ctrl + V</td>
</tr>
<tr>
<td>Delete Cell, Column, Row</td>
<td>Home, Cells</td>
<td>🗑️</td>
<td></td>
<td>Ctrl + I</td>
</tr>
<tr>
<td>or Worksheet</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fill Color</td>
<td>Home, Font</td>
<td>✉️</td>
<td></td>
<td>Ctrl + 1</td>
</tr>
<tr>
<td>Find</td>
<td>Home, Editing</td>
<td>🔍</td>
<td></td>
<td>Ctrl + F</td>
</tr>
<tr>
<td>Replace</td>
<td>Home, Editing</td>
<td>🔍</td>
<td></td>
<td>Ctrl + H</td>
</tr>
<tr>
<td>Font</td>
<td>Home, Font</td>
<td>⚈</td>
<td></td>
<td>Ctrl + 1</td>
</tr>
<tr>
<td>Font Color</td>
<td>Home, Font</td>
<td>🟢</td>
<td></td>
<td>Ctrl + 1</td>
</tr>
<tr>
<td>Font Size</td>
<td>Home, Font</td>
<td>🟢</td>
<td></td>
<td>Ctrl + 1</td>
</tr>
</tbody>
</table>
### Using Functions and Creating Charts

Excel’s built-in functions make the task of writing formulas easier. The functions are grouped by category such as statistical, financial, data, and logical. The *Insert Function* dialog box is available to assist us in locating and creating function. Charts can be easily created to emphasize or compare data sets.

Table 2.7 summarises functions and charts features in Excel 2007.

**Table 2.7: Summary of Functions and Charts Features**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Ribbon Tab, Group</th>
<th>Button</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert function</td>
<td>Formulas, Function Library</td>
<td>![fx]</td>
</tr>
<tr>
<td>Create a bar chart</td>
<td>Insert, Charts</td>
<td>![Chart]</td>
</tr>
<tr>
<td>Create a column chart</td>
<td>Insert, Charts</td>
<td>![Chart]</td>
</tr>
<tr>
<td>Create a pie chart</td>
<td>Insert, Charts</td>
<td>![Chart]</td>
</tr>
</tbody>
</table>

Using Functions and Creating Charts

Excel’s built-in functions make the task of writing formulas easier. The functions are grouped by category such as statistical, financial, data, and logical. The *Insert Function* dialog box is available to assist us in locating and creating function. Charts can be easily created to emphasize or compare data sets.

Table 2.7 summarises functions and charts features in Excel 2007.
**Activity 2.3**

**Use Correct Software Tool to Enhance the Knowledge of ICT and at the Same Time of the Chosen Subject, e.g., Using Microsoft Office Excel 2007 Create a Timeline.**

In small groups, students will use Excel 2007 to create a timeline by laying out the information along it to show how events relate over time.

**Timelines**

Timelines can tell stories, show progress, support themes and ideas, summarize details, and help us visualize trends and understand the big picture.

**What to put in a Timeline**

Text, SmartArt graphics, and pictures give the visual elements, and you can use the Excel 2007 grid to accurately lay out and align the elements. You can even build a timeline with pictures instead of words.

**Creating a Timeline Using SmartArt**

To create a timeline with SmartArt, perform the following steps:

1. Start MS-Excel 2007 to open a new worksheet.
2. On the **Insert** tab, in the **Illustrations** group, click **SmartArt** (see Fig. 2.7).
3. In the **Choose a SmartArt Graphic** dialog box, in the left navigation pane, click **Process**.
4. In the center pane, select a timeline thumbnail. The right pane displays the details of the selected thumbnail.
5. Click **OK**.
6. Position and resize the graphic by dragging the border, or resize areas (the dotted areas on the border).
7. To add text, click a text placeholder and start typing, or click the arrows on the left border and type text into the text entry box (see Fig. 2.7).
8. To add formatting and styles, select the SmartArt graphic and then select options on the SmartArt Tools **Design** and **Format** tabs.

![Fig. 2.7: Creating a timeline](image-url)
The timeline will look as shown in Fig. 2.8.

Fig. 2.8: A timeline created with SmartArt


- **Publishing Software**

*Desktop Publishing* (DTP) involves mixing text and graphics to produce high-quality output for commercial printing, using a PC and mouse, scanner, laser or ink-jet printer, and DTP software.

Microsoft Office Publisher 2007 is a DTP program with which you can create a wide variety of professional-looking publications intended for print or online presentation. Publisher provides various templates to help you structure content within a publication (or you can start from scratch), and professionally designed color palettes that can quickly change your publication into a masterpiece.

For designing purposes, you can automatically include colors, fonts, and logos into business stationary, brochures, newsletters, cards, catalogs, and may other publications. Once you have created a publication, Publisher helps you to print it, package it for professional printing, distribute it by e-mail, or publish it to a website.

**To start Publisher 2007,**

Double-click on the Publisher 2007 icon on the desktop.

or

Click *Start* → *All Programs* → *Microsoft Office* → *Microsoft Office Publisher 2007* window opens (see Fig. 2.9).

Fig. 2.9: Getting Started with Microsoft Office Publisher 2007 window
Let us revise some desktop publishing features which have been discussed in the earlier Grades.

**Creating Publications**
Publisher makes it easy to create a wide range of publications, from simple flyers to complex brochures. It offers two options for creating a new publication. From the *Getting Started* window, you can create a publication based on one of the many purpose-specific templates that come with Publisher. You can specify fonts, colors, and layout options before creating the publication. For a more original look, you can start with a blank publication; however, this is more time consuming.

**Opening Publications**
How you open an existing publication depends on what you are doing in Publisher at the time. You can open a publication in many ways.

**Editing Publications**
Publications are made up of many independent elements called *placeholders*. In Publisher, the text in a text box is called a *story*. You can add and edit text and pictures in the placeholders by clicking the designated area to activate (each placeholder is an independent element).

**Formatting Publications**
Publisher offers all sorts of tools, including shortcuts keys for navigation and formatting, to help you turn text and graphics into published material. Formatting text in a publication includes applying schemes, inserting symbols, formatting paragraphs, creating paragraph styles and formatting text boxes etc. Formatting pictures in a publication includes formatting picture frames, customizing picture appearance, inserting *WordArt*, *Design Gallery Object* etc.

**Printing Publications**
When you want to print a publication, you can print it to your computer’s default printer and with the default settings by clicking the *Print* button on the Standard toolbar. To use a different printer or change the print settings, click *Print* on the *File* menu to open the *Print* dialog box. You can then specify which printer to use, what to print, and how many copies, and you can make other changes to the print settings.

Before printing a publication, you must always check how it will look on paper by previewing it. When you print multiple copies of the entire publication, you can choose to have Publisher collate the copies (print one entire set of pages before printing the next) or print the publication on both sides of the paper.

**Saving Publications**
A newly created publication exists only in your computer’s main memory until you save it. Even if you will never use a particular publication again, you might want to save it for future use so that it might be helpful later on as the basis for a similar publication. For saving a publication first time, you can click the *Save* button on the Standard toolbar or click *Save* or *Save As* on the File menu.

After saving a publication for the first time, you can save changes simply by clicking the *Save* button on the Standard toolbar. The new version of the publication then overwrites the previous version.
Starting a New Publication or Opening an Existing One

From the *Getting Started with Microsoft Office Publisher* window, you can start a new publication or open an existing one. Some of the options for starting a new publication are:

(i) You can create a publication based on one of the many purpose-specific templates that come with Publisher. If none of these templates meet your requirements, then download a sample publication from Microsoft Office Online and customize it. You can also base publications on your custom templates.

(ii) If there is a publication that is close enough in content and design to be a good starting point, you can save a copy of that publication as the starting point for the new publication.

(iii) If your content is in a Microsoft Word document, you can import the document into Publisher and then adjust the text as you want it.

(iv) If you want to manually design the publication, you can create a new blank publication and specify the page size you want.

To create and save a publication (say a brochure) based on a template, perform the following steps:

1. Open Publisher 2007.
2. Choose *Brochures* from *Publication Types* in the left pane of the *Getting Started with Microsoft Office Publisher* window.
3. In the *Publication Types* list, click the publication category you want. Using the right pane, customize the publication (see Fig. 2.10).

   ![Fig. 2.10: Creating a brochure](image)

4. Click *Create*.

   A publication based on the selected template opens in a new Publisher program window (see Fig. 2.11).
Publisher does not have multiple views, but because publications often consist of many different elements, so zoom in and zoom out to check details or to get an overview of the entire publication.

5. Perform the desired editing and formatting on the brochure.
6. *Print Preview* the brochure and then *Print* it, if you want.
7. Save the brochure.

Table 2.8 summarises creating, editing, formatting, saving and printing publications features in Publisher 2007.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Menu</th>
<th>Button/Toolbar</th>
<th>Shortcut Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>File</td>
<td>![File icon]</td>
<td>Ctrl + O</td>
</tr>
<tr>
<td>New</td>
<td>File</td>
<td>![New icon]</td>
<td>Ctrl + N</td>
</tr>
<tr>
<td>Close File</td>
<td>File</td>
<td>![Close icon]</td>
<td>Ctrl + F4</td>
</tr>
<tr>
<td>Close active window</td>
<td>File</td>
<td>![Close active window icon]</td>
<td>Ctrl + W</td>
</tr>
<tr>
<td>Save</td>
<td>File</td>
<td>![Save icon]</td>
<td>Ctrl + S</td>
</tr>
<tr>
<td>Print Preview</td>
<td>File</td>
<td>![Print preview icon]</td>
<td>Esc</td>
</tr>
<tr>
<td>Exit Print Preview</td>
<td>File</td>
<td>![Exit print preview icon]</td>
<td>Ctrl + P</td>
</tr>
<tr>
<td>Print</td>
<td>File</td>
<td>![Print icon]</td>
<td>Ctrl + P</td>
</tr>
<tr>
<td>Exit</td>
<td>File</td>
<td>![Exit icon]</td>
<td>Alt + F4</td>
</tr>
<tr>
<td>Select All</td>
<td>Edit</td>
<td>![Select all icon]</td>
<td>Ctrl + A</td>
</tr>
</tbody>
</table>
Databases

A database is a collection of interrelated files in a computer system.

Database Management System (DBMS) is a general purpose application software that sets up and controls the structure of a database and access to the data. The most widely used form of database, especially on PCs, is the relational database, in which data is organized into related tables. Each table contains rows and columns; the rows are called record, and the columns are called field. An example of a record is a student’s address—Name, Address, City, etc. Microsoft Access is one of the principal PC database programs.

To start Access 2007,

Double-click on the Access 2007 icon on the desktop.

or

Click Start → All Programs → Microsoft Office → Microsoft Office Access 07.
The Getting Started with Microsoft Office Access window opens (see Fig. 2.12).

Click the Office Button and then click Open at the drop-down menu, or click the More hyperlink in the Open Recent Database pane or click the name of an existing database in the Open Recent Database pane.

The Access 2007 screen appears (see Fig. 2.13).

Working with Tables and Creating Tables

A table is an object that stores data. For example, a student table might store, ID, Name, Father Name, Sex, Age and Phone Number. Working in tables involves adding or deleting records, editing fields, sorting, filtering, or formatting datasheets. Access provides the Navigation pane for managing database objects.

You can create new tables by adding records to a blank datasheet, creating the table structure by defining fields etc. Each field in a table has a set of field properties, which are a set of characteristics that control how the field interacts with data in objects such as tables, forms, queries, or reports.
Table 2.9 summarises working with tables and creating tables features in Access 2007.

**Table 2.9: Summary of Working with Tables and Creating Tables Features**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Ribbon Tab, Group</th>
<th>Button</th>
<th>Quick Access Toolbar</th>
<th>Office Button Drop-down List</th>
<th>Shortcut Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>F1</td>
</tr>
<tr>
<td>Add records</td>
<td>Home, Records</td>
<td><img src="image" alt="New" /></td>
<td></td>
<td></td>
<td><strong>Ctrl + +</strong></td>
</tr>
<tr>
<td>Change font size</td>
<td>Home, Font</td>
<td><img src="image" alt="Font" /></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change margins</td>
<td>Print Preview, Page Layout</td>
<td><img src="image" alt="Page Setup" /></td>
<td>or <img src="image" alt="More" /> to open Page Setup</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Column width</td>
<td>Home, Records</td>
<td><img src="image" alt="More" /></td>
<td></td>
<td></td>
<td>Delete</td>
</tr>
<tr>
<td>Delete records</td>
<td>Home Records</td>
<td><img src="image" alt="Delete" /></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Filter</td>
<td>Home, Sort &amp; Filter</td>
<td><img src="image" alt="Filter" /></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Find</td>
<td>Home, Find</td>
<td><img src="image" alt="Find" /></td>
<td></td>
<td><strong>Ctrl + F</strong></td>
<td></td>
</tr>
<tr>
<td>Print</td>
<td></td>
<td><img src="image" alt="Print" /></td>
<td></td>
<td><strong>Print Ctrl + P</strong></td>
<td></td>
</tr>
<tr>
<td>Save</td>
<td></td>
<td><img src="image" alt="Save" /></td>
<td></td>
<td><strong>Ctrl + S</strong></td>
<td></td>
</tr>
<tr>
<td>Select all records</td>
<td>Home, Find</td>
<td><img src="image" alt="Select" /></td>
<td></td>
<td><strong>Ctrl + A</strong></td>
<td></td>
</tr>
<tr>
<td>Sort Ascending order</td>
<td>Home, Sort &amp; Filter</td>
<td><img src="image" alt="Sort Ascending" /></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sort Descending order</td>
<td>Home, Sort &amp; Filter</td>
<td><img src="image" alt="Sort Descending" /></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Primary key</td>
<td>Table Tools Design, Tools</td>
<td><img src="image" alt="Primary Key" /></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Datasheet view</td>
<td>Home, Views</td>
<td><img src="image" alt="Datasheet" /></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Design view</td>
<td>Home, Views</td>
<td><img src="image" alt="Design" /></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fill Color</td>
<td>Home, Font</td>
<td><img src="image" alt="Fill Color" /></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Font Size</td>
<td>Home, Font</td>
<td><img src="image" alt="Font Size" /></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Gridlines</td>
<td>Home, Font</td>
<td><img src="image" alt="Gridlines" /></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Insert totals</td>
<td>Home, Records</td>
<td><img src="image" alt="Total" /></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Creating Queries

A *query* is a database object that you can work with in Access. You can locate specific information stored in a table, or in multiple tables, by creating a query specifying the parameters of the information you want to find. Running a query (also called *querying* the database) displays a datasheet containing the records that fit the search criteria. The set of records returned by a query is known as *dataset*. You can use the query results as the basis for further analysis.

If you want to locate records matching the search criteria at any time in the future, you can save the query, and run it again from the *Queries* section of the *Navigation Pane*. Each time you run a query, Access evaluates the records in the specified table (or tables) and displays the current subset of records that match the criteria you have defined.

Creating Forms

A *form* is a database object that you can work with in Access. You can easily enter, edit, delete, retrieve, display, and print information, by creating a form through which people can interact with your database.

A form is essentially a window having controls that either display information to people or accept information that people enter. Access provides a collection of standard Windows controls such as labels, text boxes, option buttons, and check boxes. With a little skill, you can create forms that look and work much like the dialog boxes in all Windows applications.

A form acts as a friendly interface for a table. Through a form, you can display and edit the records of the underlying table, or create new records. As with tables and queries, you can display forms in several views. The three most common views are:

1. **Form View**, in which you enter data.
2. **Datasheet View**, which looks essentially like a table.
3. **Design View**, in which you work with the elements of the form to refine the way it looks and works.

Most forms link to only one table, but if you want to link to multiple tables from one form, you can embed other forms (*subforms*) within a form (then referred to as the *main form*).

Creating Reports

A *report* is a database object that you can work with in Access. Reports are used for presenting information in a customized format, either on computer screen or on paper. A report can include items of information selected from multiple tables and queries, values calculated from information in the database, and formatting elements such as headers, footers, titles, and headings.

You can look at reports in four views:

1. **Design View**, it allows you to manipulate the design of a report in the same way that you manipulate a form.
2. **Report View**, where you can scroll through the information in the report without the page breaks inserted when it is printed.
3. **Print Preview**, it allows you to see your report exactly as it will look when printed.
4. **Layout View**, which displays the data in the report (similar to Print Preview) but enables you to edit the layout.
Table 2.10 summarises creating queries, forms, and reports features in Access 2007.

**Table 2.10: Summary of Creating Queries, Forms and Reports Features**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Ribbon Tab, Group</th>
<th>Button</th>
<th>Shortcut Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add fields to a form</td>
<td>Form Tools Formatting, Controls</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create query in Design view</td>
<td>Create, Other</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Design view</td>
<td>Home, Views</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Form tool</td>
<td>Create, Forms</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Form view</td>
<td>Home, Views</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Form Wizard</td>
<td>Create, Forms</td>
<td></td>
<td>More Forms</td>
</tr>
<tr>
<td>Layout view</td>
<td>Home, Views</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Minimize Navigation pane</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Redisplay Navigation pane</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Report tool</td>
<td>Create, Reports</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Simple Query Wizard</td>
<td>Create, Other</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Split Form tool</td>
<td>Create, Forms</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Activity 2.4**

**Create a Database Project that is Used to Create Customer Database**

In small groups, the students will create a database project that is used to create customer database.

**Planning and Designing a Database**

First of all design a table for a new database by breaking down all of the information into individual fields. Keep in mind the future needs for both input and output. Include the fields that may be used in future. For example, add a field for a website address even if you do not currently have URLs for your customers.

**Project:** Create a new table to store the customer information.

To create a table for customer information, perform the following steps:

2. Click Create tab.
3. Click on Table Design.
4. Type field names, change data types, add descriptions, or modify other field properties as desired.

5. Assign primary key by making desired field active and clicking Primary Key button.
6. Click Save button.
7. Type table name.
8. Click OK.

The customer table details are shown in Fig. 2.14.
9. Now enter the records in the table. Figure 2.15 shows the customer table after entering the records.

KEY CONCEPTS

- Software required to solve some specific task of daily use is generally called application software.
- Word processor is general purpose application software that facilitates creation and formatting of text documents.
- Presentation software is general purpose application software that facilitates creation of presentations on any particular topic.
- Spreadsheet is general purpose application software that facilitates creation of worksheets that stores text and numerical data in tabular form. Performing basic statistical analysis including graphs is the main utility of this software.
- Publishing software is general purpose application software that facilitates creation of a wide variety of professional-looking publications intended for print or online presentation.
- Database Management System (DBMS) is a general purpose application software that facilitates creation, maintenance, and the use of database for an organization and its end users.

Review Questions

Fill in the Blanks
1. ...................... software is used to carry out a specific task like word processing, desktop publishing, etc.
2. ...................... is general purpose application software that facilitates the creation of textual documents with extensive formatting.
3. ...................... are used for maintaining student grade books, calculating loan payments, and creating other types of financial reports, etc.
4. DBMS is a software that sets up and controls the structure of a ...................... and access to data.

State Whether True or False
1. Typewriter offers a much improved way of dealing with documents than word processing software.
2. Presentation software uses graphics, animation, sound, and data or information to make visual presentations.
3. Microsoft Publisher is not a DTP software.
4. Microsoft Access is a database software.

Multiple Choice Questions
1. To make data entry easier in a database, you can create a ......................
   (a) Report  (b) Form  (c) Operator  (d) Query
2. With the ...................... mode on, anything you type in a document will replace existing text.
   (a) Undertype  (b) Fixtype  (c) Doubletype  (d) Overtype
3. In MS-Excel, all formulas begin with ........................................... sign.
   
   \[(a) = \quad (b) > \]
   \[(c) < \quad (d) ? \]

4. A ........................................... is a location on a slide marked with a border that holds text or an object.
   
   \[(a) \text{ Scroll box} \quad (b) \text{ Ribbon} \]
   \[(c) \text{ Placeholder} \quad (d) \text{ Vertical Scroll bar} \]

**Match the Following**

<table>
<thead>
<tr>
<th>Column A</th>
<th>Column B</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. To look up a synonym</td>
<td>[(a)] Used to start a new publication or open an existing one</td>
</tr>
<tr>
<td>2. Animation tab</td>
<td>[(b)] Used to view specific fields from table that meet a particular criterion</td>
</tr>
<tr>
<td>3. Query</td>
<td>[(c)] Use a thesaurus</td>
</tr>
<tr>
<td>4. Getting started window in Publisher 2007</td>
<td>[(d)] Used to add transitions and sounds</td>
</tr>
</tbody>
</table>

**Answer the Following**

1. Define the term application software. List some general purpose application software and their uses in problem solving.
2. What is word processing software? Explain its usage areas.
3. What is presentation software? Explain its usage areas.
4. What is spreadsheet software? Explain its usage areas.
5. What is publishing software? Explain its usage areas.
6. What is database software? Explain its usage areas.

**Suggested Activities**

1. Design a project where you can apply the knowledge of Word, Excel, Database and Presentation software.
2. Create a database project that is used to create student database.
3. Prepare a presentation for your project.
4. Prepare a brochure for your school to apply desktop publishing knowledge.

**Field Trip**

Using the Internet or computer magazines, look up information on Microsoft Office 2010. List any features you find. List which of these features appeal to you and describe why they do.
UNIT 3 – Exploiting the Internet

UNIT OUTCOME

**Students will be able to:**
- understand the concept of webpage design;
- understand and differentiate between the different kinds of websites;
- recognize the steps required for website design;
- design a simple and attractive website.

3.1 GENERAL CONCEPT OF WEBSITE DESIGN

You have already studied about basic concepts of Internet and WWW in Grades 9, 10 and 11. In this unit, we will further exploit the Internet.

- **Definition of Website**
A computer with a domain name is called a website (site). Figure 3.1 shows the Microsoft Office website.

![Microsoft Office website](office.microsoft.com)

---

**Fig. 3.1: Microsoft Office website (office.microsoft.com)**
### Definition of Webpage

A webpage is a document on the World Wide Web that can include text, picture, sound, and video. Figure 3.2 shows a webpage.

![Fig. 3.2: A webpage](image)

### Home Page

The first page you see at a website is like the title page of a book. This is the home page, or welcome page, which identifies the website and contains links to other pages of the site. Figure 3.3 shows the home page of the website www.ethiopiantreasures.co.uk.

![Fig. 3.3: Home page of the website www.ethiopiantreasures.co.uk](image)
If you have your own website, it might have just one page—the home page. Large websites have hundreds of pages.

The contents of home page often change. Or they may disappear, and so the connecting links to them in other webpages become links to nowhere.

**Types of Website**

There are basically two main types of websites—*static* and *dynamic*.

1. **Static Website:** It is a site like a printed paper as it is unchangeable once it is printed. It is usually built using several tools such as Kompozer or Dreamweaver. People are not able to change your webpage if you have a static website other than if you use WYSIWYG (What You See Is What You Get), text editors and template based editors. Only you may edit or transform your static website. For example, someone’s web portfolio is an example of a static site. It is only one page and is updated on average once a month.

2. **Dynamic Website:** It is a site which allows the user to share data with the website. It is usually built with a programming language such as ASP, PHP or JAVA. Now-a-days most business websites are dynamic. One may enter his/her info when registering on the site as well as being able to buy products and services. For example, www.paypal.com.

**Some Well-established Websites**

Some well-established websites are listed below:

(i) www.yahoo.com
(ii) www.google.com
(iii) www.utube.com
(iv) www.telecom.net.et
(v) www.ethep.anrev.et.com
(vi) www.h5.com
(vii) www.nazret.com
(vii) www.ebay.com

**Application of Website**

There are several applications of websites on the Internet each specializing in a particular service or use. Some are selling something, some are entertaining everyone and some just want to share their knowledge with others. Some websites act as vehicles to communicate with other people in the form of blogs. The different applications of websites are educational, commercial, governmental and entertainment etc.

**Educational Website**

Education forms an integral part in developing an individual’s character. There are many online sites offering detailed information on education. For example, www.kidknowit.com. Figure 3.4 shows one of the best educational website (www.thegateway.org).
Fig. 3.4: An educational website

Commercial Website

Commercial websites operate as online businesses. For example, firebrand.com. Figure 3.5 shows a commercial website (www.ebay.com).
Governmental Website

A governmental website contains general information about that country, its arts, culture, historic sites, economy, and government, and news etc. For example, www.mfa.gov.et. Figure 3.6 shows a governmental website (www.moe.gov.et).

Entertainment Website

Entertainment is a part of life. There are many online sites which are source for entertainment news, celebrity gossip and pictures. For example, www.eonline.com. Figure 3.7 shows an entertainment website (www.addiszen.com).
Activity 3.1

Demonstrate the Difference Between Static and Dynamic Website

In small groups, the students will demonstrate the difference between static and dynamic website.

Static Website

This is a website whose content can only be changed by the web developer. It can be seen as an online brochure or catalogue. It is one of the most common and simplest to set up. It can showcase your personal information, products or company online in a great style. It is also extremely practical for starters on the Internet. It is easily navigable and browser friendly too. However, it is not simple to improve because alterations would require Web programming mastery. Hence, a static website is rather appropriate where modifications are not required.

Figure 3.8 shows a static website developed by a student, namely Senya Ali of Addis Ababa city in Ethiopia.

Advantages of Static Website

(i) Quick to develop
(ii) Cheap to develop
(iii) Cheap to host

Disadvantages of Static Website

(i) Requires web development expertise to update site
(ii) Content can get stagnant

Dynamic Website

A dynamic website provides flexibility so you can supplement and modify elements, stories, data, pictures, announcements and videos anytime without the aid of any webmaster. In simple words, a dynamic website provides the administrator the ease to manage the whole portal, without having to involve the developer, without having to pay each time and without having to get involved with any design or programming.
Figure 3.9 shows a dynamic website www.howstuffworks.com.

Advantages of Dynamic Website

(i) Much more functional website
(ii) Much easier to update
(iii) New content brings people back to the site and helps in the search engines
(iv) Can work as a system to allow staff or users to collaborate

Disadvantages of Dynamic Website

(i) Slower/more expensive to develop
(ii) Hosting costs a little more

Now-a-days a dynamic website is the way to go for a business as the competition in every sector of business is very high, the consumers are becoming more and more demanding, asking to be better informed and they insist in receiving a better and urgent service.

3.2 PLANNING A WEBSITE

In designing a website you should take into account the website’s purpose and audience. A good designer knows how to achieve the effects called for in the most flexible, efficient, and elegant way. To design a website, you should have a thorough knowledge in hypertext, multimedia, Java, and other programming possibilities as well as knowledge about how particular website structures affect an audience.

- Determining the Purpose of the Website

Determining the purpose of the website is most important for its success. First of all you should develop a plan. With a good plan, you may know in advance what you are going to do and the correct order in which all things need to be done.
The important questions to be considered are:

(i) Why you want to create a site?

(ii) What do you want or expect your site to accomplish?

(iii) Are you planning on using your site to generate a passive income by sell products or information or it is just for friends and family?

(iv) Is it because others are doing it?

Some common purposes for Websites are:

(i) **Online Store**: It is the most important reason for building a website. If your primary purpose is selling physical goods, focus on creating an online store that gives visitors simple and easy shopping.

(ii) **Brand Awareness**: If your primary focus is on delivering an offline service, you may want an online brochure. This sort of website can deliver useful, practical information about your service and help you to develop your image and build trust and customer loyalty.

(iii) **Online Services**: For delivering an online service, you will have to build an infrastructure for the delivery of your service. This type of website is more complex and you will need to anticipate what you will feature in your product catalogue, and how you will handle online payments and process online orders.

(iv) **Affiliate Commissions and Advertising**: Another reason for building a website may be to make money through promoting affiliate programs, which offer you a commission on sales. You may want to earn money by putting up the banners of other business on your website. To earn a sufficient amount of money, you would require hard work and planning.

Clearly defining the purpose of your website, before you start building it, would ensure that your website is optimized to achieve the required purpose. After all, you can only meet your goals when you know what they are. You will have to balance your business goals, the needs of your audience, and your resources to create an effective website.

No matter what the purpose of your website may be, make sure that you keep track of the visitors of your website. A traffic tracking system would give you valuable information about the persons that are visiting your website. It would also enable you to make important decisions related to the optimization of your website.

**Content Identification**

Planning is the first step in building a good website. After determining the purpose of the website, the website designer must plan the content. The content of a website is everything that is in it. The contents may include one or all of the following:

(i) The text on web pages.

(ii) The graphics in the website.

(iii) The colors and style of the website.

The important points to be considered about the content of a website are:

(i) What content will it contain?

(ii) What content will drive people back to it?
(iii) What are the sources for content?
(iv) Who will write the content?

The content of website is to provide the users or customers with information. Planning the content of a website is a much more comprehensive project than it first appears. To properly plan content for a website it is necessary to first make assumptions on what will be of most value to visitors. There are many tools to aid in the planning phase of website creation. Some useful online tools for planning a website are:

(i) JumpChart (URL: www.jumchart.com)
(ii) RapidRabbit (URL: rapidrabbit.it)
(iii) WriteMaps (URL: www.writemaps.com)
(iv) MindMeister (URL: www.mindmeister.com)

A good website developer will be able to utilize the above mentioned online tools and other offline tools (for these visit the websites www.balsamiq.com, www.giffy.com, www.auxre.com) along with the information from the content manager to decide on which information will be most important for a website.

The content of website is the stuff that draws and keeps an audience. The composition of the content should follow directly from the stated website purpose and audience. So the website designer can prepare a set of content features that relate to the audience’s activities, interests, and concerns. For example, a website about a school ICT fair might list rules of the fair, the location and details about the upcoming events, statements by judges, and descriptions of past winning projects.

Always remember that website design process builds on its content.

Truly great websites pay attention to content and organization. The content of a website must be determined by the type of website and its purpose.

**Knowing the Audience**

A website designer should know about his/her website’s audience. It may be family, friends, and potential employers. Using age appropriate material helps ensure that the online audience will remain interested and continue to visit the website. The websites which want to attract the young viewers should follow current trends and incorporate music, graphics and special effects that hold their interest. For older viewers these may have 3D graphics and soothing music. Website designs that have too much information are often difficult to navigate and may also deter the less experienced Internet audience.

Figure 3.10 shows that knowing the audience is the first key step in creating a well designed website.
3.3 WEBSITE DESIGN CONSIDERATIONS

While designing a website, you must consider that a successful website should have clearly identified goals and provide useful and attractive content that draws your audience to your site again and again. In addition, it must be easy to navigate and also attractively designed to complement the content.

- **Page Layout of the Website**

  A web designer must know the fundamentals of good layout, that is, how to make the webpages more effective and pleasing to the eye.

  While designing the page layout, consider the following basic principles:

  (i) Create a Visual Theme that is consistent.
  (ii) Align elements on the page.
  (iii) Use contrasting color and text weight effectively.
  (iv) Group elements together so that the reader can more easily grasp the information you are presenting.
  (v) Make intelligent use of images including images that display text.

  Figure 3.11 shows a page layout for a webpage.

  ![Fig. 3.11: Page layout for a webpage](image)

- **Create Content**

  Create a list of all of the content that you would like to include on your website that both achieves your goals and would be of interest to your audience. At this point, just write whatever comes to mind; do not try to organize it.
Use of Images
An image might be the focal point of a webpage. Your eye is drawn to an image because it is an image, not because of the position it has in the layout. So, look at the other elements on the page to make small changes (e.g. position and spacing etc.) to the elements and margins around the image to create an interesting design. Also the captions should go with each image separately.

Align your images. Balance the graphics and text on a page. When you are considering your layout, remember that images are the major part of the design, not just afterthoughts.

Page Size (Creating and Formatting Tables)
Designing a professional looking website involves much more than simply displaying text. Page size plays an important role while designing webpages. In order to organize your page, you can use tables. Tables will change the look of the webpage. Originally, tables let people present data (mostly numbers) in a column format. Designers have found the ways to improve the layout of their pages using tables. Although a bit complicated and sometimes difficult to understand, tables do improve your layout and let you present your material in a more eye-appealing way.

• Fonts (Adding Design Elements)
Text is one of the most important parts of a webpage. The way in which you display the text on your webpage will have a great impact on its success. It can make your page look very professional or very unprofessional.

When placing text within your webpage, always be consistent with your fonts i.e., do not use different fonts throughout your pages. The standard fonts used on the Internet are Arial and Verdana as they are the easiest to read on a computer screen. The standard text size is 2. Headlines, which require a larger font size, are a bit different. A popular headline font used is Georgia, as it displays nicely in a slightly larger font size.

Busy backgrounds make the text difficult to read and draw the attention away from the text. In addition, always be consistent with your background theme on each page of your site.

Figure 3.12 shows the contents of a webpage under consideration in two ways.

![Page Title](Image)

In this example, we mix text and graphics.

Notice how the page looks disorganized.

![Page Title](Image)

In this example we have mixed text and image.

This page is more effective than the sample on the left.

Here, we have arranged text and image properly.

Fig. 3.12: Different ways of arranging contents on a webpage
3.4 WEBSITE DEVELOPMENT

For developing a website, you require web design software. Web Page Maker is an easy-to-use web creator that helps you make your own webpages with no experience or HTML knowledge. Just drag and drop images, text, music and video… into a layout. During the edit process, you can easily move the objects with your mouse to anywhere on the page. Web Page Maker has some high quality features.

To start Web Page Maker,

Click Start → All Programs → Web Page Maker → Web Page Maker

The Web Page Maker window opens. Now, you can easily develop your website in the Work window, using the Toolbar and Site panel.

Adding Text

Click on Text button in toolbar to add text. Click on Work window and set the size of text box.

Double-click in the created Text Box. It will open the Text Editor. Type the desired text and click OK.

The typed text in the Text Editor will appear in your webpage. Similarly you can add text at other places of the webpage by adding separate text boxes and typing text in them. Format the text as per your need. After adding the text the webpage looks like the page shown in Fig. 3.13.

Adding Image

For adding image click Insert → Image → From files…

The Open dialog box appears. Select the image to be inserted and click Open button. The selected image will be inserted on the Webpage. Drag and resize the image as per your requirement (see Fig. 3.14).
Creating Hyperlinks
A hyperlink connects the webpage with other pages of website or to pages on other websites.

To add links (hyperlinks), select the text box and click on the Hyperlink button on the toolbar.

It will open the Hyperlink dialog box. Setup the Link Type and other options. Click OK. Similarly set the hyperlinks of the desired websites for the other text boxes (see Fig. 3.15).

![Fig. 3.15: Creating hyperlinks on a webpage](image)

Inserting Table
To insert the table, click Insert → Table... It will open the New Table dialog box. Type the number of Rows and Columns. Click OK. It will open the Table Editor. Type the contents of table and apply the desired fonts. Click OK. The table will be inserted in the selected webpage (see Fig. 3.16).

![Fig. 3.16: Inserting table on a webpage](image)

Inserting Frames
A frame is used to post information from one webpage to another. To insert frames click Insert → iFrame.... It opens the iFrame dialog box. Enter the Web URL of the website. Click OK. It will insert a iFrame in the webpage (see Fig. 3.17).
Information Communication Technology — Grade 12 Student Textbook

By clicking on Iframe, we can see the contents of another webpage linked through the hyperlink.

- **Adding Web Effects**
  To add web effect to your webpage right click on the work area and click on Properties.... It will open the Page Properties dialog box (see Fig. 3.18).

  ![Fig. 3.18: Page Properties dialog box](image)

  Click Page Transition tab and add the desired effect to your webpage. Click OK. The effect will be applied in your webpage.

- **Inserting Animations**
  To insert animation click Insert → Marquee. It will insert an animation text box on the webpage. Double-click to open the Text Editor. Enter the text and click OK. The animation effect of the text box will be applied on the webpage (see Fig. 3.19).
Using Scripts

A script is a program or sequence of instructions that is interpreted or carried out by another program rather than by the computer processor. For example, *JavaScript* is a script language. We can insert various scripts in our webpage for producing special effects on webpage.

To insert the script click **Insert → Ready-to-use JavaScripts**…. The **Ready predefined JavaScript** dialog box opens. Select the java script you want to insert on your webpage and click **OK**. The selected java script will be inserted on the webpage (see Fig. 3.20).

Using Java Applets

Java is a programming language that can be used to create both standalone programs (`.exe` files) and programs that run in webpages (`.class` files). The web based programs are called **Applets**.

Inserting applets into your webpages involves specifying the following information:

1. Name of the applet class file.
2. Size of the applet.
(iii) Path to the folder containing the applet (if that folder is not the folder that contains the index.html file).

(iv) Any parameters the applet needs.

(v) XHTML code for browsers that do not support Java.

1. If you get applets from other designers, the applets should come with documentation that gives the XHTML code to be used to insert the applets in webpages. Remember that you may use different folders and will have to modify the paths to the folders accordingly. When downloading the class files, do a shift-click on the download links so you will download the .class files and not the .exe files. If you download .zip files, you will have to unzip them.

2. Not all browsers can handle Java, and not all people who have Java-capable browsers surf with Java enabled. Thus, before you use Java in your website, you need to be satisfied that your intended audience will be able to see your applets.

To insert Java Applets,
Click Insert → Html code or Script code.

The Html Editor dialog box opens (see Fig. 3.21).

Now use the <applet> tag of HTML to specify the path and class file of the java applet to be inserted in the webpage.

Click OK. The java applet will be inserted in the selected webpage (see Fig. 3.22)
Exporting design to HTML

To export the website to HTML,

Click **File → Export to HTML**

Browse the folder where you want to place your HTML file.

Let us place the HTML file in C:\New Folder

Now, go to the selected folder, *i.e.*, C:\New Folder (see Fig. 3.23) and open the `index.html` file in your Web browser.

![Fig. 3.23: Selecting index.html file for browsing](image)

Your webpage will look like Fig. 3.24.

![Fig. 3.24: Webpage shown in the web browser](image)
KEY CONCEPTS

- A computer with a domain name is called a website (site). There are basically two main types of websites—Static and dynamic.
- In designing a website you should take into account the website’s purpose and audience.
- While designing a website, you must consider that a successful website should have clearly identified goals and provide useful and attractive content that draws your audience to your site again and again.
- For developing a website, you require web design software. For example, Web Page Maker.
- A hyperlink connects the webpage with other pages of webpage or to pages on other websites.

Review Questions

Fill in the Blanks

1. A computer with a domain name is called a .................................. .
2. The purposes of a website influences .................................., .................................., .................................. and .................................. .
3. For developing a website, you require .................................. design software.
4. A .................................. connects the webpage with other pages of website or to pages on other websites.

State Whether True or False

1. A static website is one of the most common and simplest to set up.
2. A website cannot be designed for business, sharing information or personal interest.
3. A web designer must know the fundamentals of good layout, that is, how to make the webpages more effective and pleasing to the eye.
4. Java is a programming language that can be used to create programs that run in web pages (.class files).

Multiple Choice Questions

1. A/an .................................. is a document on the World Wide Web that can include text, pictures, sound and video.
   (a) Modem (b) Webpage (c) Uniform Service Locator (d) Internet Service Provider
2. Which of the following is/are type(s) of websites?
   (a) Static (b) Dynamic (c) Both (a) and (b) (d) None of these
3. Which of the following is/are common purpose(s) of a website?
   (a) Online store and Brand Awareness (b) Online services (c) Advertising (d) All of these
4. Which of the following is/are application(s) of websites?
   (a) Educational (b) Commercial (c) Governmental (d) All of these
Match the Following

<table>
<thead>
<tr>
<th>Column A</th>
<th>Column B</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Home Page</td>
<td>(a) Web design software</td>
</tr>
<tr>
<td>2. Hyperlink</td>
<td>(b) Person who plans website development</td>
</tr>
<tr>
<td>3. Website designer</td>
<td>(c) The first page you see at a website</td>
</tr>
<tr>
<td>4. Web Page Maker</td>
<td>(d) Connects webpages</td>
</tr>
</tbody>
</table>

Answer the Following

1. Define website. Explain the different types of websites. List some well-established websites.
2. How will you identify the type of website to be developed?
3. Describe website planning.
4. Explain how to design a webpage. How will you insert hyperlinks, images, buttons and animations to a webpage?
5. How will you develop content for a website with uniform formatting?

Suggested Activities

1. Identify the following:
   (i) Knowing the audiences  
   (ii) Selecting technology to use  
   (iii) Design of the web architecture  
   (iv) Web content development  
   (v) Hosting the website to a web server.
2. Discuss about the points to consider in planning a website.
3. Explain the steps involved in website design with practical examples.
4. Discuss the ways of adding different effects to a website.
5. Write a report discussing what must be considered when designing a website. Develop your draft design into a website. The site should have at least three pages, and should include the following design elements:
   - Adding and modifying graphics elements
   - Adding navigational elements
   - Adding links
   - Creating image maps and hotspots
   - Creating navigational structure
   - Adding Web effects
   - Inserting animations
   - Inserting interactive buttons
   - Resources: PCs access to the Internet, web design software.
6. Demonstrate skill using a Java script and Java applets in your website.

Field Trip

Organize a field trip to some nearby educational institutions, organizations, and Ethiopian Telecommunication Corporation (ETC) stations to find out and report on:
Exploiting the Internet.
UNIT OUTCOME

Students will be able to:

- recognise components of multimedia and work with these components effectively;
- understand the meaning and use of multimedia production;
- create interactive applications using multimedia applications.

4.1 BASICS OF MULTIMEDIA

In this sub-unit, we will learn about basics of multimedia.

- Definition of Multimedia

*Media* is the means of communication *i.e.*, plural of medium. *Multimedia* is the combined use of several media, such as motion-pictures, slides and music. Or in other words, multimedia refers to technology that presents information in more than one medium—such as text, pictures, video, sound, and animation—in a single integrated communication. The development of the World Wide Web expanded the Internet to include pictures, sound, music, and so on, as well as text.

Multimedia is media that utilizes a combination of different content forms (see Fig. 4.1).

![Fig. 4.1: Multimedia contains a combination of content forms](image)

- Importance of Multimedia

Multimedia is appropriate whenever a human interface connects a human user to electronic information of any kind. Multimedia improves information retention. When it is properly constructed, multimedia can be entertaining as well as useful. The importance of multimedia grows as new technology develops.
Multimedia plays an important role in the following fields:

1. **Business**: The Internet provides the general public with website hosting and building that lets multimedia enhance an idea. These websites, blogging and social platforms give businesses a way to enhance their progress. Business applications for multimedia include presentations, training, marketing, advertising, product demos, simulations, databases, catalogs, instant messaging, and networked connections.

2. **Education**: Schools in Ethiopia are perhaps the destination most in need of multimedia. Computer-assisted programs like Microsoft PowerPoint have allowed classrooms to use graphics and visuals to do presentations in creative ways. Interactive graphics make learning more visually enhanced and can clarify ideas. Students can also design and run websites.

3. **Home**: Multimedia has entered the home via TVs and is used for gardening, cooking, home design, remodeling etc. Today, home consumers of multimedia use a computer with CD-ROM or DVD drive for their different type of activities.

4. **Recreation**: People are able to watch movies and listen to audio, read books with multimedia access on their laptop computers. This allows people to entertain themselves wherever they go.

5. **Engineering**: Software engineers may use multimedia in computer simulations for anything from entertainment to training such as military or industrial training. Multimedia for software interfaces are often done as collaboration between creative professionals and software engineers.

6. **Public Places**: Multimedia is available at stand-alone terminals or kiosks used in hotels, at railway stations, shopping malls, museums, libraries. The way we live is changing as multimedia penetrates our day-to-day experience and our culture. Today, multimedia is found in churches and places of worship as live video with attached song lyrics shown on large screens using elaborate sound systems with special effects lighting and recording facilities.

7. **Communication**: Multimedia platforms can be used as a communication device that can link to two people from different regions of the world. People are able to talk over the computer through chatting, social networking and through video cameras.

In summary, we can say that multimedia is very useful in education, training, marketing, advertising, product demos, databases, catalogs, entertainment, and networked communications.

**Components of Multimedia**

The multimedia components are:

1. **Text**
   
   In the past, content was produced primarily via text. Though additional elements have been added, text remains vital to multimedia applications. This is because text is still an effective way to communicate. In multimedia, text is used as headlines, subtitles, and captions. In addition to supplying content, text is used to give directions and communicate information, text-based menus and buttons help guide users through the multimedia applications, and electronic books, magazines, and reference materials still rely on text to inform and educate.

2. **Graphics**
   
   Because most people like illustrations, visuals, graphics, 2D and 3D images are crucial to multimedia development. In fact, multimedia applications are predominately graphic. Because they play such a critical role, balancing graphics is essential. When designing a multimedia application, it is important not to get carried away with graphics. Adding just the right graphic and just the right number of graphics may help the user learn and retain more information in less time and with less effort.
Graphics that fit most needs are quite easy to find. Commercially prepared drawings called clipart come packaged with many application programs. Charts, another type of graphics, can convey a great deal of information in a very limited space. Photographs can also be used to enhance multimedia applications.

When a graphic or other multimedia object serves as a link to additional information about a topic, the link is called hypermedia.

3. Animation

Animation refers to graphic images that change or move. Animation can convey information, add visual interest, or draw attention to important information or links in a multimedia application. Animation is commonly used in advertising and marketing on the Web because the movement does grab the visitor’s attention. By illustrating proper techniques or explaining complex procedures, animation can also serve as an excellent learning aid in computer-based training programs.

Like clipart and stock photography, animated graphics are available for purchase on CD-ROM or they can be downloaded from the Internet. In addition, commercial software and shareware can be purchased or downloaded and used to create simple or complex animations.

4. Sound

By incorporating sound into a multimedia application, you require the user to make use of yet another sense. This enhances the experience and increases the likelihood of user understanding and enjoyment.

In multimedia applications, sound that has been digitized is called audio. Audio can be obtained by capturing sound into a personal computer using a microphone, CD-ROM, or other input device. It can also be played from a synthesizer, keyboard, or other musical instrument that is connected to the computer using MIDI (musical instrument digital interface) port.

5. Video

Video can do a great deal to enhance a presentation, illustrate a proper technique, or advertise a new product. Video files are photographic images played at speeds that make it appear as if the images are in full motion. Video files are incredibly large because a huge number of images are required to give the appearance of motion. Delivering video over the Internet is particularly challenging.

Interactive multimedia allows users to respond directly to and control media elements. Users of interactive multimedia become active participants in an application instead of passive recipients of information.

- **Hardware and Software Requirements for Multimedia**

  A *multimedia computer system* is a computer capable of integrating two or more types of media (text, graphics, animation, audio and video) for generation, storage, representation, manipulation, and access of multimedia information.

![Fig. 4.2: Typical multimedia computers](https://example.com/fig4.2.jpg)
For using multimedia on a computer system, it needs certain hardware components and software resources to be present.

**Hardware Requirements for Multimedia**
The basic hardware requirement for multimedia are:

1. Central Processing Unit (CPU) — Pentium Processor
2. Random Access Memory (RAM) — 1 GB RAM
3. Monitor — Super Virtual Graphics Arrays (SVGA)
4. Video Card
5. Sound Card
6. CD-ROM Drive

**Software Requirements for Multimedia**
The basic software requirement for multimedia are:

1. Word Processor for entering text
2. Image Processing software such as Photoshop, CorelDraw, etc.
3. Animation creator like 3D Max, Flash, etc.
4. Sound can be created using Sound forge, etc.
5. Video can be used by using software like Video for Windows, Author Ware, etc.

**Multimedia and Hypermedia**

**Multimedia**
It is the integration of sound, animation, and digitized video with more traditional types of data such as text. It is an application-oriented technology that is used in a number of ways, for example, to enhance presentations, and is based on the increasing capability of computers to store, transmit, and present many types of information. Some examples of multimedia applications are: business presentations, online newspapers, distance education, and interactive gaming.

**Hypermedia**
It is an enhancement of hypertext, the non-sequential access of text documents, using a multimedia environment. It provides the users the flexibility to select whatever document they want to view based on their current interests. The path followed to get from document to document changes from user to user and is very dynamic. This “make your own adventure” type of experience sets hypermedia apart. The best example of hypermedia is World Wide Web.

The major difference between multimedia and hypermedia is that the user is more actively involved in the hypermedia experience, whereas the multimedia experience is more passive.

### 4.2 MULTIMEDIA AUTHORING

Multimedia authoring involves collating, structuring and presenting information in the form of a digital multimedia, which can incorporate text, audio and still and moving images. In this sub-unit, we will learn about multimedia authoring.
• Stages of Multimedia Authoring

The five stages of multimedia authoring are:

1. **Analysis**: What do you need to do and what do you use to do it.
2. **Design**: Create storyboards to tell the story of the project.
3. **Development**: Incorporate data and set it up as a prototype or model.
4. **Evaluation**: When the prototype application works the way you want it to, test it again, fine-tune it, make it attractive, and then review your work.
5. **Distribution**: When it is ready to go (after the evaluation phase), make it real. Package and distribute it.

• Authoring Tools Examples

Authoring can be described as creating highly interactive applications in which the information can flow in both the directions i.e., from application to user and from user to application. Multimedia packages and authoring tools help us in creating higher quality audio and video applications with little expertise.

Some multimedia authoring packages are:

(i) Macromedia Authorware
(ii) Adobe Premier
(iii) Macromedia Flash
(iv) Everest Authoring System
(v) Icon Author
(vi) ImageQ

Some multimedia authoring tools are:

(i) Computer
(ii) Scanner
(iii) Digital camera
(iv) Sound recorder

• File Formats of Sounds, Image and Video

In many cases electronic publications include images, photographs and may be some video and sound, too. Images and photographs can be inserted into inside the actual document or be linked to the document.

There are dozens of different file formats for images, video and sound. The most common ones are given below:

**File Format for Sound**

(i) WAV (Windows Wave Format)
(ii) MIDI (Musical Instrument Digital Interface)
(iii) WMA (Windows Media Audio)

**File Format for Image**

(i) TIFF (Tagged Interchange Format)
(ii) JPEG (Joint Photographic Experts Group)
(iii) GIF (Graphics Interchange Format)
(iv) PNG (Portable Network Graphics)
(v) BMP (Windows Bitmap Format)

**File Format for Video**

(i) AVI (Audio Video Interleave)
(ii) MPEG (Moving Picture Experts Group)
4.3 INTRODUCTION TO MULTIMEDIA AUTHORING TOOLS

Multimedia authoring tools are the tools that are used for creating various types of multimedia applications. Here, we will learn about these tools.

- **Screen Elements of Multimedia Application**

We should open a multimedia application for having a look at the screen elements. Here, we are using Macromedia Flash.

**To open Macromedia Flash,**
Click *Start → All Programs → Macromedia → Macromedia Flash MX.*

Figure 4.3 shows the Macromedia Flash screen elements.

![Figure 4.3: Macromedia Flash screen elements](image)

Table 4.1 describes some screen elements of Macromedia Flash MX.

**Table 4.1: Macromedia Flash MX Screen Elements**

<table>
<thead>
<tr>
<th>Screen Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu bar</td>
<td>It contains various menus for commands.</td>
</tr>
<tr>
<td>Work area</td>
<td>It consists of Flash stage (White area in the middle of Work area) and Workspace (grey area).</td>
</tr>
<tr>
<td>Timeline window</td>
<td>It controls when things happen during playback of movie. For example, playback time, frame rate etc.</td>
</tr>
<tr>
<td>Layer panel</td>
<td>It controls the layers (The transparent overlays on the stage where different objects can be placed). It is an integral part of the timeline.</td>
</tr>
<tr>
<td>Toolbox</td>
<td>It contains all the tools you need for drawing or selecting objects.</td>
</tr>
<tr>
<td>Panels</td>
<td>Flash makes extensive use of panels (The different parts of the screen). For example, option panel, action panel, properties panel etc.</td>
</tr>
</tbody>
</table>
● Creating a New Project
To create a new project,
Click File → New.
It will open a new project file.
Your new project can be in the form of a drawing, shape, or even an animation.
Let us start with a simple project, i.e., drawing a rectangle and fill it with colors.

● Building a Basic Piece
You can draw a basic drawing piece in work area by using various drawing tools (Line Tool, Rectangular Tool, Oval Tool, etc.) from the toolbox.

To insert a rectangular box perform the following steps:
1. Click on Rectangle Tool.
2. Draw a rectangle box in the work area.
3. Click on the Paint Bucket Tool and select the desired color from Color Swatches.
4. Click inside the rectangle box and fill the color (see Fig. 4.4).

Now save your basic piece with a suitable file name.
To save the file,
Click File → Save or press Ctrl + S.
Another type of project which can be created using a multimedia is Animation.
For this we can rotate the figure at different angles.
When we run the project it gives the impression of an animation.
To apply the animation on the basic piece, perform the following steps:
1. Click the first frame in the layer you want to frame.
2. Place the object you want to animate or just insert an image from the clipart.
3. Click the next frame in the *Timeline* window.
4. Add a keyframe. Flash inserts a keyframe that duplicates the previous frame’s contents.
5. Change the object slightly; change it to $90^\circ$ to the right.
6. Repeat the steps 4 and 5. This time image will turn face down.
7. Now again repeat the same steps, making the figure turn to $270^\circ$ so that it now faces to the left.
   This way you can change the angle to a smaller degree and make frames if you want to have real fun.
8. Click at first keyframe in the layer and press *Enter* key to see the animation.
   Your animation will be shown on the screen (see Fig. 4.5).

![Fig. 4.5: Showing an animation](image.png)

To preview the animated test movie, click *Control* → *Test Movie* or *Ctrl + Enter*.

- **Editing an Icon**

An icon is an element (graphical, textual, audio, video) which we can see or listen using Graphical User Interface (GUI), for example Windows or X-Windows (a GUI for many operating systems like Linux and UNIX etc.). In other words, an icon is a broad term associated with multimedia elements.

During creation of multimedia projects it is necessary to modify properties like appearance, placement, size, time duration, and other animation related items. It is known as editing an icon.

To edit an icon, perform the following steps:
1. Select the icon by clicking on it.
   Now you can see the properties of the selected icon at the bottom of screen in the *Properties* panel.
2. Change the displayed properties as per your need like contents, sound, color etc.
3. After making the changes, you can run and pause the project to see the edited icon. If still not satisfied with the modifications, you can re-edit the icon.

### 4.4 INSERTING AND EDITING TEXT

In this sub-unit, we will learn about inserting and editing text in multimedia applications.

- **Inserting Display Icons**
  Display icons are those icons that display some image or graphic. These are available in the form of various items such as symbols, tools, figures, text etc. These are available individually or in combinations. So, you can use them the way you want. The process of inserting display icons and graphic icons is similar.

- **Inserting Text into a Text Field**
  To insert text, perform the following steps:
  1. Open a new project file.
  2. Click on **Text Tool** button.
  3. Click and drag a text field in the work area.
  4. Type the desired text and click anywhere in the work area to deactivate the text field.
  Figure 4.6 shows a text inserted in the new project.
• Importing and Pasting Text

To import a file, perform the following steps:

1. Open a new project.
2. Click File → Import. The Import dialog box opens.
3. Select the desired file and click Open.
4. The selected file will be imported in the work area.

To paste the text, perform the following steps:

1. Open a new project.
2. Select and copy the desired text from the document you want.
3. Now return to your project file and click Edit → Paste or press Ctrl + V.

The selected text will be pasted in the project file.

• Defining and Applying Text Style

To define and apply text style, perform the following:

1. Click on the Text Tool button.
2. From the Properties tool panel (see Fig. 4.7) lying below the work area, set your desired Text type, Character position and Character Spacing, etc.

3. Now, draw the text field by using click and drag, and enter your text. The text style will be applied to the text.

   ![Fig. 4.7: Properties tool panel](image)

   If Properties panel is not displayed, then select the Text Tool, right click on the work area and click on Properties.

• Editing and Formatting Text as Required

To edit and format text, perform the following steps:

1. Click on the text field, edit the text you want.
2. Now select the text entered in the text field and set the desired font, alignment, color, etc. from Properties tool panel (see Fig. 4.8).
4.5 WORKING WITH IMAGES AND GRAPHICS

In this sub-unit, we will learn about working with images and graphics.

- **Importing an Image or Graphic; Pasting an Image or Graphic**

To import an image, perform the following steps:

1. Click on *File* → *Import*.
2. The *Import* dialog box opens.
3. Select the image you want to import and click *Open*. The image file will be imported to your project (see Fig. 4.9).

**Fig. 4.8: Editing and formatting text**

**Fig. 4.9: Importing an image**
To paste an image, perform the following steps:
1. Copy the desired image you want to paste.
2. Click Edit → Paste
   or
   Press Ctrl + V to paste image.
3. The image will be pasted in your project.

● Modifying an Image or Graphic
To modify the image or graphic, perform the following steps:
1. Select the image by clicking on it.
2. Click on Free Transform Tool button in the toolbox. A boundary box will be applied on the image or graphic.
3. Now, in the op ions panel, select the operation (Rotate and Skew, Scale, Distort, Envelope).
   The desired operation will be applied on the image or graphic.

4.6 PAGE TRANSITIONS, POSITIONING AND MOTION ICON

In this sub-unit, we will discuss about Page Transitions, Positioning and Motion Icon.
Here, we will use Adobe Premiere Elements 9. It is one of the premiere software for working with sounds and digital movies.

To open Adobe Premiere Elements 9,
Click Start → All Programs → Adobe Premiere Elements 9
Figure 4.10 shows the opening screen of Adobe Premiere Elements 9.

Fig. 4.10: Opening screen of Adobe Premiere Elements 9
Transitions

Transitions let you add effects to phase out one clip and phase in the next, and then preview the transition before applying it. You can customize audio and video transitions as gradual fades or have one clip replace another.

Using transitions, you can phase out one clip while phasing in the next or you can stylize the beginning or end of a single clip. A transition can be as subtle as a cross dissolve, or emphatic, such as a page turn or spinning pinwheel.

You generally place transitions on a cut between two clips, creating a double-sided transition. However, you can also apply a transition to just the beginning or end of a clip, creating a single-sided transition, such as a fade to black. When a transition shifts from one clip to the next, it overlaps frames from both clips. The overlapped frames can either be frames previously trimmed from the clips (frames just past the In or Out point at the cut), or existing frames repeated on either side of the cut. It is important to remember that when you trim a clip, you do not delete frames; instead, the resulting In and Out points frame a window over the original clip. A transition uses the trimmed frames to create the transition effect, or, if the clips do not have trimmed frames, the transition repeats frames.

To see if a transition is single-sided or double-sided and if it has repeated frames, select it and click Edit Transition in the Transition view of the Task panel to view it in Properties view.

Selecting Transitions

There are many transitions to choose from that come with Adobe Premier Elements 9. First time filmmakers tend to overuse this feature. Only add a transition when it makes sense otherwise they tend to distract from the video. Add transitions after editing and before adding the soundtrack.

You can select the desired transition effect by clicking Edit → Transitions. Figure 4.11 shows various types of transitions effects.

Positioning Objects

You have full flexibility in adjusting an object’s position, rotation, scale, and opacity—attributes collectively referred to as transform properties. To transform an object, you can drag in the Monitor panel or choose a command from the Title menu.
• **Types of Positions**
  You can choose the different types of positions of transition effect like Start, End, and Centre etc. from the Transition properties window. It can be opened by clicking on *Edit Transition* button.

• **Type of Motion**
  We can customize different types of motion by using different drawing tools such as Line Tool, Oval Tool, Rectangle Tool, and Lasso Tool. Figure 4.12 shows Zig-zag motion.

![Fig. 4.12: Zig-zag motion using Line Tool](image)

• **Using Motion Icon**
  Motion is a special layer effect that an object shows during its movement. Creating a motion is quite simple in Macromedia Flash MX. We can generate the motion effect by creating a guide layer.

  In this section, we will add motion to an object.

  To use motion icon in Macromedia Flash MX, perform the following steps:

  1. Create a graphic symbol or drag a pre-existing graphic symbol from library onto the stage. Name the layer as *Graphic*.
  2. Right click on *Graphic* label and select *Add Motion Guide* from the pop-up window (see Fig. 4.13).

![Fig. 4.13: Adding Motion Guide to the selected layer](image)
A new layer will appear on top of the *Graphic* layer with the label *Guide Graphic* along with the guide icon.

3. Draw the path for your symbol in this new layer using pencil or line tool. For example: Draw a circle.

4. Select frame 60 of guide layer and press “F5” to insert frames (see Fig. 4.14).

5. Now go to *Frame 1* of *Graphic* layer and drag your symbol to one end of your path. While dragging, you will see a bubble on the symbol. That bubble should go right below the path.

6. Now go to *Frame 60* of *Graphic* layer and press F6 to insert a new keyframe.

7. Now drag your symbol to other end of your path. Again, the bubble should go right below the path.

8. Select any frame between 1 to 60 of your *Graphic* layer. Right click and select *Create Motion Tween* from the pop-up menu (see Fig. 4.15).

9. Press Ctrl + Enter to view your work.
4.7 LIBRARIES

In this sub-unit, we will learn about libraries.

The multimedia library contains visual and audio element (Icons) required for developing new multimedia contents. The contents are often in the form of audio and video files. To ensure full access the users must have the appropriate software to view the multimedia files.

- **Creating**
  You can use the sample libraries included with Flash to add symbols, buttons, or sounds to your documents. You can also create your own sample libraries, which you can then use with any documents that you create.

  **To create a sample library for your Flash application, perform the following steps:**
  1. Create a Flash file with a library containing the symbols that you want to include in the permanent library.
  2. Place the Flash file in the Libraries folder located in the Flash application folder on your hard drive.

- **Saving**
  We can save our information to the Flash application library, so that it is available for future use.

  **To save the information, perform the following steps:**
  1. Click *File* → *Save As*.

  The *Save As* dialog box opens (see Fig. 4.16).

![Fig. 4.16: Save As dialog box](image-url)
2. Identify the location where you want to save the file.
3. Give a suitable file name and click **Save**.

**Opening and Closing**

**Opening the Library**

To open a library, perform the following steps:

1. Click **File** → **Open as Library**
   
   The **Open as Library** dialog box appears (see Fig. 4.17).

   ![Fig. 4.17: Open as Library dialog box](image)

2. Browse the library file and click **Open**.

**Closing the Library**

To close the library,

   Click **File** → **Close** or press **Ctrl + W**.

   Another way of closing the library is to exit the application or open another library file.

**Selecting a Library**

When the Open as Library dialog box opens, you can select the desired library file.
94

Unit 4 – Image Processing and Multimedia Systems

- Adding Icon to the Library
  To add an icon to the library, perform the following steps:
  1. Open a library file.
  2. Click File → Import or press Ctrl + R.
     The Import dialog box will be opened.
  3. Choose the desired icon file and click Open.
     An icon for that file will be added in the library.

- Using an Icon From a Library
  To use an icon from a library, perform the following steps:
  1. Open the library file.
  2. Select the desired icon from the library by double-clicking it.

4.8 WORKING WITH SOUND AND DIGITAL MOVIES

In this sub-unit, we will learn about working with sound and digital movies:

- Sound Icon
  Sound icon is the graphical representation of inserted or available audio file in project or library. Figure 4.18 shows a sound icon.

- Importing Sound
  You can import various sound in the project.
  To import the sound file, perform the following steps:
  1. Click Organize → Get Media → Files and Folders.
     The Add Media dialog box opens.
  2. Browse the audio file you want to import and click Open.
     The selected audio file will be imported in the project (see Fig. 4.19).
Fig. 4.19: Imported Sound

- **Changing the Sound’s Play Speed**
  
  To change the sound’s play speed, perform the following steps:

  1. Drag the imported audio file to the Timeline (see Fig. 4.20)

  ![Fig. 4.20: Dragging sound to Timeline](image)

  2. Right click on the imported sound waveform and click *Time Stretch*.

  3. The *Time Stretch* dialog box opens (see Fig. 4.21).

  ![Fig. 4.21: Time Stretch dialog box](image)

  4. Set the play back speed and click **OK**.
- **Working with Digital Movies**

Digital video is a type of video recording system that works by using a digital rather than an analog video signal. We can work on digital movies using Adobe Premiere. It allows various operations such as trimming, motion, audio enhancing and adding transition effect etc.

- **File Formats**

Adobe Premiere supports several file formats for audio and video files such as MP3, MP4, AVI, MPG, WAV, and WMV etc.

- **Importing a Digital Movie**

To import a digital movie, perform the following steps:

1. Import your digital media clip or movie by clicking **Organize → Get Media → Files and Folders.**
2. Browse the video file and click **Open.**
3. The selected video file will be imported to your project (see Fig. 4.22).

![Fig. 4.22: An imported video](image)

- **Setting Playback Conditions**

We can set various playback conditions from the audio properties such as Fade In, Fade Out, Bypass, Balance, Time Duration, Toggle, Repeat and Clip Volume. To open audio properties dialog box, right click on the dragged audio file in Timeline and click **Show Properties** (see Fig. 4.23).
4.9 OVERVIEW OF FILM EDITING

In this sub-unit, we will learn the basics of film editing:

- **Basics of Film Editing**
  The process of editing clips includes previewing and trimming them to eliminate unnecessary material. It also includes revising clip properties such as speed, direction, and duration. You can also edit media clips generated by other programs in their original applications, from within Adobe Premiere Elements.

- **Trimming Video Clips**
  You can create a refined good-quality video file by removing unwanted sections and low-quality sections. Adobe Premiere Elements 9 enables you to efficiently handle blurred, shaky, and unwanted low-quality and low-interest sections of your video file. You can easily and quickly edit and fine-tune the video files. Smart trimming enables you to trim the low-quality sections of a video file. Smart trim can be done manually and automatically. You can trim clips from Timeline view or Sceneline view. However, you can trim only one clip at a time from the Sceneline view. Smart trimming is of two types, manual and automatic. Manual Smart trimming is the default mode. In this mode, you can specify the options.
that determine the trimmable sections. In the automatic Smart trim mode, Adobe Premiere Elements automatically determines the trimmable sections and you can choose to delete them or retain them. Figure 4.25 shows the trimming of a video clip.

**Changing Clip Speed and Duration**

**Changing Clip Speed**

To create a fast- or slow-motion effect, we can change clip speed. Changing clip speed changes the clip’s duration. Speeding up a clip removes frames, thus shortening the clip duration. In the same way, slowing down a clip repeats frames and thus adds to the length of a clip. For audio clips, a change in speed also changes pitch. The Time Stretch command includes an option to maintain the original pitch of an audio clip at any speed.

You can change a clip’s speed using the Timeline only—not the Sceneline.

When you change the speed of a clip containing interlaced fields, you may need to adjust how Adobe Premiere Elements processes the fields, especially when the speed drops below 100% of the original speed.

**Set the Duration of a Clip**

The *duration* of a video or audio clip is the length of time it plays from its first frame (In point) to its last frame (Out point). The initial duration of a clip is the same as it was when the clip was imported or captured. Most often, you change a clip’s duration by trimming frames from either end. But you can also trim the end of a clip by designating a specific duration.

Unlike video, still images are not limited to the length of the original clip. You can set their duration to any length.
Freezing and Holding Frames

Export a Video Frame
You can grab a single frame from a video clip to use as a still image in your current movie or to save as a still on your hard drive for use elsewhere. For example, you can use a still in your movie to show a character start an action, but then stop mid-action, frozen on the screen.

Play and Hold a Frame
To make the video start out as a still image and then begin to play, click the Freeze Frame button 📸 in the Monitor panel to create a still image from a frame, and then insert that still image at the location of the original frame. Figure 4.26 shows a freeze frame.

Activity 4.1

DIFFERENTIATE MULTIMEDIA AND HYPERMEDIA
In small groups, the students will explain and demonstrate the difference between multimedia and hypermedia.

Multimedia
Multimedia is media that uses multiple forms of information content and information processing like text, audio, graphics, animation, video, interactivity to inform or entertain the audience. Figure 4.27 shows some multimedia tools.
Multimedia is very useful in various areas including, but not limited to, education, entertainment and fine arts, engineering, medicine, mathematics, business, scientific research etc.

**Hypermedia**

The World Wide Web (WWW) has become without doubt the best-known and most widely used hypermedia system (see Fig. 4.28).

Most Web navigation is done by clicking text-based links that open new pages in a Web browser. These links, which are often blue and underlined are referred to as hypertext, since they allow the user to jump from page to page. Hypermedia is an extension of hypertext that allows images, movies and Flash animations to be linked to other content.

Hypermedia systems are very popular tool for user-driven access to information. These are very useful in various areas such as online documentation systems, application systems with advanced help and explanation facilities, educational systems etc.

**KEY CONCEPTS**

- Multimedia is the combined use of several media, such as motion-pictures, slides, and music.
- Multimedia authoring involves collating, structuring and presenting information in the form of a digital multimedia, which can incorporate text, audio and still and moving images.
- Multimedia authoring tools are the tools that are used for creating various types of multimedia applications.
- Display icons are the ones that display some image or graphic.
- The wait icon provides a way to pause or delay any onscreen action. Delay can be a set time interval or may require a mouse click to continue.
- The multimedia library contains visual and audio elements (icons) required for developing new multimedia contents.
- The process of editing clips includes previewing and trimming them to eliminate unnecessary material. It also includes revising clip properties such as speed, direction, and duration.
Review Questions

Fill in the Blanks
1. ...................................... refers to technology that presents information in more than one medium—such as text, pictures, video, sound, and animation—in a single integrated communication.
2. The components of multimedia are .................................., .................................., .................................., .................................., and .................................. .
3. ...................................... let you add effects to phase out one clip and phase in the next clip.
4. MIDI, JPEG and MPEG are file formats for .................................., .................................., and .................................. respectively.

State Whether True or False
1. Multimedia does not utilize a combination of different content forms.
2. Hypermedia is an enhancement of hypertext, the non-sequential access of text documents, using a multimedia environment.
3. In multimedia packages, using pre-stored libraries, creating libraries and adding and using icons is not possible.
4. Macromedia Authorware, Adobe Premier, and Macromedia Flash are multimedia packages.

Multiple Choice Questions
1. Which of the following field(s) use multimedia?
   (a) Business  (b) Education  (c) Home  (d) All of these
2. The best example of hypermedia is .................................. .
   (a) World Wide Web  (b) Hardware  (c) Printout  (d) None of these
3. TIFF stands for .................................. .
   (a) Transitional Image File Format  (b) Total Inclusion File Format  (c) Tagged Interchange File Format  (d) Temporary Instruction File Format
4. ...................................... is an object actually moving across, into, or out of the screen.
   (a) GIGO  (b) Animation  (c) WMA  (d) Trimming
5. Which of the following hardware is used in Multimedia Authoring tool?
   (a) Computer  (b) Scanner  (c) Sound Recorder  (d) All of these

Match the Following

<table>
<thead>
<tr>
<th>Column A</th>
<th>Column B</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Multimedia</td>
<td>(a) Includes previewing and trimming them to eliminate unnecessary material</td>
</tr>
<tr>
<td>2. Macromedia Authorware</td>
<td>(b) Combines two or more media together</td>
</tr>
<tr>
<td>3. Editing clips</td>
<td>(c) An sound file format</td>
</tr>
<tr>
<td>4. WAV</td>
<td>(d) Multimedia authoring package</td>
</tr>
</tbody>
</table>
Answer the Following

1. Define multimedia. Discuss its components also.
2. List and explain the stages of multimedia authoring.
3. Identify screen elements of Multimedia application Macromedia Flash shown below:

4. Give the steps to import sound files.
5. Write a short note on basics of film editing.

Suggested Activities

1. The teacher will explain and demonstrate stages of multimedia authoring and authoring tools examples like Macromedia Authorware, Adobe Premier, Macromedia Flash and the students will practice.
2. The teacher will explain and demonstrate the steps involved in using sound and in working with digital movies and the students will practice.
3. Design and produce a multimedia presentation on an idea or theme of your own which has relevance to the work you are doing in Grade 12.
4. Explain how to insert, edit and format text in the presentation windows of Multimedia Authoring.
5. Explain how to import and paste images, graphics and movies from other applications.
6. Explain how to set the time duration:
   - before content on the presentation window is erased,
   - to erase the contents of a presentation window.

Field Trip

Organize a field trip to various business houses and publications around you to get useful information about Image Processing and Multimedia Systems being used currently and present it to the class.
**GLOSSARY**

**A**

**Absolute Reference:** Commonly used in spreadsheet applications, it is a formulated cell reference that will not adjust when used to calculate the sum of specific cells.

**Address Book:** In e-mail, list of regular contacts’ addresses held in the e-mail software.

**AI (Artificial Intelligence):** It is the branch of computer science concerned with making computers behave like humans.

**Animation:** The display of a sequence of images in a computer program or on a Webpage to give the impression of movement.

**Application Software:** A program that is designed to perform specific tasks.

**B**

**B2B (Business-to-Business):** Companies doing business with each other such as manufacturers selling to distributors and wholesalers selling to retailers constitute B2B type of e-commerce.

**B2C (Business-to-Consumer):** It comprises of businesses selling to the general public typically through catalogues utilizing shopping cart software.

**Backup:** To copy files or data to a second source or media so as to safeguard it.

**Binary:** A basic numbering system consisting of 1s and 0s.

**BIT (Binary Digit):** It is the smallest unit of processing of computerized data in terms of 1s or 0s.

**Blog:** (Slang term for a Weblog) A blog is a personal journal that can be accessed publicly and allow people to comment on the previously posted comments.

**BMP (Bitmap):** It is a standard uncompressed format for Microsoft Windows and IBM OS/2.

**Browser:** Software program that allows the user to find and read encoded information in a form suitable for display especially on World Wide Web.

**Byte:** A combination of 8 bits to represent computer data transfer or data storage measurement.

**C**

**CD-ROM (Compact Disc Read-Only Memory):** A durable and low cost circular optical storage device widely used to store large amounts of information.

**Clipart or Clip Art:** A collection of image files that can be embedded or inserted into Web pages, word-processed documents, PowerPoint presentations, etc.

**Compiler:** A type of system software that translates a source program usually written in a high level language into a machine language.

**Computer:** An electronic device that accepts, processes, stores and outputs data under the control of a set of instructions.

**Cropping:** The process of removing portions of an image to create focus or strengthen the composition.

**CPU (Central Processing Unit):** A processor on an IC chip (called a microprocessor) that serves as the ‘brain’ of the computer.
**D**

**Database**: A structured collection of data that can be used for a variety of purposes.

**DBMS (Database Management System)**: Application software which enables the storage, modification, retrieval, and querying of data in a database.

**Desktop Publishing (DTP)**: Application software for laying out text, graphics and pictures in order to produce a professional-looking publication.

**Display Icons**: The icons that display some image or graphic.

**Domain Name System**: An addressing system in which abbreviations are used to indicate the type of organization or entity instead of whole name, for example .edu for educational institution.

**Downloading**: It means transmitting data from a remote computer to a local computer, as from a website to your own PC.

**DVD**: Digital Versatile Disc or Digital Video Disc.

**E**

**E-Banking**: Use of computer and e-technology as a substitute for checks and other paper transactions.

**E-Business**: Business involving transactions using electronic media and technology.

**E-Commerce**: Buying and selling or business transaction conducted on the Internet.

**E-Governance**: Application of electronic means in governance.

**E-Government**: Government’s use of information technology to exchange information and services with citizens, businesses, and other arms of government.

**E-Learning**: Means of teaching through e-technology.

**E-Libraries**: The physical sites and/or websites that provide 24-hours online access to digitized audio, video, and written material.

**E-Mail**: Stands for Electronic Mail. This is a system of relaying messages across the Internet, from one Internet user to another.

**Encryption**: A system of coding that helps prevent access to private information on computer networks or on the Web.

**F**

**Flash Player and Flash Professional**: Software produced by Adobe for the development and viewing of animated and interactive sequences on the Web.

**Forms**: Used to provide an easy to use interface for user to enter, view and modify data in a table.

**Format Painter**: Helps to copy the format that has been applied to text and apply it to another.

**FTP (File Transfer Protocol)**: A software protocol for exchanging information between computers over a network.

**G**

**GIF (Graphics Interchange Format)**: It is pronounced “jif”, supports upto 256 colours (8 bits per pixel).

**Gigabyte (GB)**: 2 to the 30th power (1,073,741,824) bytes. One gigabyte is equal to 1,024 megabytes.

**GIGO**: It is an acronym that stands for Garbage In, Garbage Out.

**Google**: A popular search engine.

**GUI (Graphical User Interface)**: A program interface that takes advantage of the computer’s graphics capabilities to make the program easier to use. Well-designed graphical user interfaces can free the user from learning complex command languages.

**H**

**Hacker**: A person who spends his/her time trying to gain access to information stored on other people’s computers all around the world.
Hardware: The physical equipment used in a computer system, such as the CPU, peripheral devices and memory.


HTML: Hypertext Markup Language. It is a collection of structuring and formatting tags used to create Web pages.

Hyperlinks: A word or graphic display on one web page that allows a computer to shift to another related web page.

Icon: A picture or symbol to represent a command on a computer screen.

Image Processing: The set of computational techniques for analyzing, enhancing, compressing, and reconstructing images, generally with a digital computer.

Information: Meaningfully organized data.

Information System: A system that provides information to people in an organization.

Internet Explorer: A browser produced by the Microsoft Corporation and supplied together with the Windows operating system.

Integrated Circuit (IC): A circuit of transistors, resistors, and capacitors constructed on a single semiconductor wafer or chip, in which the components are interconnected to perform a given function.

Interpreter: It translates and executes source program, written in high level language, statement-by-statement.

Internet: The Internet is a network of networks all of which use the same set of communications protocols.

ISP (Internet Service Provider): A company that provides access to the Internet.

JAVA: A high-level programming language developed by Sun Microsystems.

Joystick: A device that looks a bit like a gear lever in a car. This is connected to a computer and is used mainly for controlling the cursor in fast action games.

JPEG (Joint Picture Experts Group): It is pronounced “jay peg”. It supports 16.7 million colors (24 bits per pixel).

Keyboard: An input device which is used to enter information which the computer displays or processes.

Kilobyte (KB): This is about a thousand bytes of space. In reality, it is two to the 10th power or 1,024 bytes.

LAN (Local Area Network): A network that links together computers and peripheral equipment within a limited area, such as a building or a group of buildings.

Language Processor: Software that converts a high level language or assembly language code into machine understandable form.

Laser Printer: A type of printer that produces high-quality output at a reasonable speed.

Learning Management System (LMS): A software package that enables the management and delivery of learning content and resources to students.

Login: To attach to a computer using the user’s ID.

M-Commerce: Buying and selling of goods and services through wireless technology.
**Glossary**

**Megabyte (MB):** About a million bytes of space. Actually it is $2^{20}$ or 1,048,576 bytes of space.

**Memory:** Internal storage areas in the computer.

**Microsoft Office:** A suite of programs produced by Microsoft Corporation, comprising a Word-processor (Word), a Spreadsheet (Excel), a Presentation Program (PowerPoint), an Email package (Outlook), a Database program (Access), and a Desktop Publishing package (Publisher).

**Moodle:** An Open Source Course Management System (CMS), also known as a Learning Management System (LMS) or a Virtual Learning Environment (VLE).

**MPEG (Motion Picture Experts Group):** A format to make, view, and transfer both digital audio and video files.

**MS-Access:** Database application software, provided by Microsoft.

**MS-Excel:** Spreadsheet application software, provided by Microsoft.

**MS-PowerPoint:** Presentation software, provided by Microsoft.

**MS-Word:** Word processing application software, provided by Microsoft.

**Multimedia:** The integration of two or more types of information (text, images, audio, video, animation, etc.) in a single application.

**Multimedia Authoring:** It involves collating, structuring, and presenting information in the form of digital multimedia, which can incorporate text, audio, and still and moving images.

**Multimedia Authoring Tools:** Tools that are used for creating various types of multimedia applications.

**Navigation:** It is the process of finding the way, i.e., navigating, around a series of menus within a computer program or finding the way around the World Wide Web by means of a browser.

**Netiquette:** The rules of etiquette that apply when communicating over computer networks, especially the Internet.

**Network:** A system containing any combination of computers and its peripherals, used to transmit or receive information.

**Offline:** Not connected to a computer or network of computers.

**Online:** Connected to a computer or network of computers, especially the World Wide Web.

**Operating System:** A system software program that works as a bridge between computer hardware and the user. Operating systems perform basic tasks, such as recognizing input from the keyboard, sending output to the display screen, keeping track of files and directories on the disk, and controlling peripheral devices such as disk drives and printers.

**Outlook:** A popular e-mail program, part of the Microsoft Office suite of programs.

**PDF (Portable Document Format):** A technology developed by Adobe and was designed to capture all of the elements of a printed document and place it in a single image file.

**Pixel:** The smallest element of an image that can be individually processed in a video display system.

**Plotter:** A computer output device that draws images on paper using a pen.

**Portal:** A Webpage, website or service that acts as link or entrance to other websites on the Internet.

**Primary Key:** A set of one or more values in a database that uniquely identifies a record in a table.

**Protocol:** A set of rules governing the format of messages that are exchanged between computers.
Q

Query: Used to retrieve information on a certain condition from a database.

R

Relative Reference: The default reference in a spreadsheet package.

Reports: Used to present data in a printed format.

Resolution: A measure of the number of pixels or small dots displayed on a computer display screen, printer or scanner.

S

Scanner: A device used to convert hard copy, e.g., a printed page, photograph or photographic negative, into a form that can be stored on a computer.

Search Engines: A computer program that searches documents, especially on the World Wide Web, for a specified word or words and provides a list of documents in which they are found.

Server: This is a mainframe computer that serves the other computers attached to it.

Sheet Tab: In spreadsheet applications, this refers to a tab at the bottom of a worksheet that acts as a means to identify or access different sheets within a workbook.

Slide Show: Used to display the slides in a desired sequence.

Software: The set of instructions used to direct the operation of a computer, as well a documentation giving instructions on how to use them.

Social Networking: The grouping of individuals or organizations into specific groups.

Source data: Data for which the chart is prepared.

Spam: The disruptive unwanted messages, especially commercial messages posted on a computer network or sent as e-mail.

Spreadsheet: A document which helps to organize data in rows and columns that intersect to form cells.

System: Collection of related components that interact to perform a task in order to accomplish a goal.

Systems Analysis and Design: A six-phase problem-solving procedure for examining an information system and improving it.


System Software: It is a set of master programs that keeps the computer system working.

T

Technology: It is the usage and knowledge of tools, crafts, techniques, or systems, or methods of organizations.

Telecommunication: The transmission of messages over significant distances for the purpose of communication.

Terabyte (TB): 2 to the 40th power (1,099,511,627,776) bytes.

TIFF (Tagged Image File Format): It stores compressed files with a flexible number of bits per pixel.

Toolbar: A row or rows of buttons on a display screen that are clicked on to select various functions in a software application or web browser.

Twitter: A microblogging facility that allows users to post very short texts (maximum 140 characters) containing snippets of information about what they are doing at a given moment, news items, links to websites or comments on events.

U

Uploading: It means transmitting data from a local computer to a remote computer, as from your PC to a website you are constructing.
**URL (Uniform Resource Locator):** A protocol for specifying addresses on the Internet. It is an address that identifies a particular file on the Internet, usually consisting of the protocol as http, followed by the domain name.

**User-friendly:** Mainly used to describe software. Software that is easy to use and offers guidance if the user does silly things is described as user-friendly.

**V**

**Virus:** A program or piece of code that is loaded onto your computer without your knowledge and runs against your wishes.

**W**

**W3C (World Wide Web Consortium):** An international non-profit organization which acts as a resource centre for the World Wide Web, and is active in setting technical standards.

**WAV:** Stands for WAVeform sound format. Microsoft’s format for encoding sound files.

**Webcam:** A camera connected to a computer and linking it to the Internet.

**Web page or Webpage:** A single, usually hypertext document on the World Wide Web that can incorporate text, graphics, sounds, etc.

**Web server:** A computer that runs specific software to serve web pages to the Internet.

**Web site:** A connected group of pages on the World Wide Web regarded as a single entity, usually maintained by one person or organization and developed to a single topic or several closely related topics.

**Wizard:** A utility that provides guided sequence to perform complex task easily and quickly.

**Word Processor:** Software that processes textual matter and creates organized documents.

**WWW (World Wide Web):** Series of servers or computers that are interconnected through hypertext.

**WYSIWYG:** What You Say Is What You Get.

**XML (eXtensible Markup Language):** It is a markup language, not limited to Web documents.

**YouTube:** A website to which we can upload our own video clips and view video clips uploaded by others: http://www.youtube.com.

**Zip Disks:** The disks with a special high-quality magnetic coating that have a capacity of 100, 250 or 750 megabytes.